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ABSTRACT
The hazard posed by Mount Cleveland in Alaska’s central Aleutian Islands is the
interaction between erupted ash and aircraft. The understanding of these potential hazards
can be applied to other threatening volcanoes in the Aleutian Islands. Remote sensing
satellites have been useful for constraining the chronological events of the 2001 eruption
activity. Thermal infrared data is analyzed for maximum estimated thermal flux of 15.3
GW and maximum effusion rates of 4.6 m3/s during the February 19, 2001 eruption.
These thermal estimates are compared to known field observations of the deposits to
better classify the eruption sequence and activity. This sequence on the western flank of
volcaniclastic debris-lahar-lava is similar to the stratigraphy of past deposits nearby. Posteruption analysis of satellite and field observation data provide a useful view into the
erosion of a 1.2 x 106 m3 volcaniclastic debris flow fan deposit from the eruption along
with continued morphologic changes of the volcano. Areal analysis of the fan deposit in
radar imagery from March 31, 2001 until December 21, 2003 indicates an average
decreasing trend of 20 m2/day. This unique chance to determine the erosion rate of this
deposit may be applied to similar eruption deposits at other island volcanoes.
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1.0 INTRODUCTION
More than 80 active volcanoes have erupted during the Holocene in Alaska, 40 of
these during historic times (Miller et al., 1998). The majority of these active volcanoes
are stratovolcanoes that usually erupt explosively, but also produce effusive (i.e. lava
flow) eruptions. These remote and active volcanoes comprise the Aleutian Island
volcanic arc, which is sparsely populated with only a few remote villages scattered
throughout the chain (Figure 1.1). Some of these villages are in the shadows of these
active volcanoes making them vulnerable to several volcanic hazards (i.e. ash fallout,
lahars, pyroclastic flows, and tsunamis are the most frequent). The volcanoes of the
Aleutian arc, along with the Kamchatka-Kurile volcanic arc of eastern Asia, have the
ability to cripple the heavily traveled air routes in the North Pacific region. The potential
interactions of air traffic with ash clouds make this hazard the most dangerous threat
(Figure 1.2). Understanding the source and characteristics of the volcanic deposits is
instrumental to determining what hazards are more critical to communities in the North
Pacific and other volcanic areas of the world.
The intent of this study is to use the chronology and thermal characteristics of the
2001 eruptions from Mount Cleveland volcano in Alaska’s Aleutian Islands to determine
its eruptive style, and to use change detection to investigate the erosion of a newly
formed deposit. The first of three objectives is to compile the most up to date chronology
of the 2001 Mt. Cleveland eruption. Questions to be addressed for this objective are: (a)
How and when did a volcaniclastic debris flow fan deposit on the western flank form?,
and (b) Has there been continued activity at the volcano since the end of the eruptions in
March 2001? For very recent and well-known eruptions, an examination of the
chronology of events can lead to a better understanding on how the volcano behaves
during active cycles. The chronology can also provide scientists with a better
understanding to how past eruptions from that volcano, and even other similar volcanoes,
may have taken place. Filling in gaps of the eruptive observation record, especially in
remote regions like the Aleutian Islands, is an area where remote sensing can aid field
expeditions to a volcano.
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Figure 1.2. Contrails from heavy North Pacific air traffic. The black arrow at the bottom depicts one of the
many condensation trails (or contrails; linear brighter features) from the engine exhausts of aircraft seen
in this band 3 image from NOAA-14 on March 17, 2001 at 1816 UTC. The location of Mount Cleveland is
indicated in red. Two days after this image, Mount Cleveland had its third eruption within two months.
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The second objective of this study is to use thermal data from remote sensing
satellites to constrain the type of activity that occurred during the eruptions. Activity such
as eruption ash plumes/clouds and thermal anomalies (sometimes termed “hotspots” in
satellite images) are the focus in satellite images during routine monitoring at the Alaska
Volcano Observatory (Dean et al., 1998; Dehn et al., 2000; Schneider et al., 2000; Dehn
et al., 2002; Dean et al., 2002a; Dean et al., 2002c; and Dean et al., 2004). Where ash
plumes indicate recent activity, thermal anomalies can provide insight into the restless
nature of the volcano. Other studies have shown that thermal anomalies can be precursor
signals of explosive eruptions (Dehn et al., 2002; and Wright et al., 2002) and signs of
continuing activity (Dean et al., 1998; Dehn et al., 2000; and Patrick et al., 2003).
Thermal flux and effusion rates derived from satellite data are a useful means of gauging
the volcanic activity at the time of a satellite acquisition (Harris et al., 1997a; and Harris
et al., 1997b). In addition to constraining the type of activity occurring at the volcano (i.e.
degassing, lava flows, and/or lahars), these data constrain when the onset or cessation of
activity has occurred.
The final objective of this study is to investigate any continued erosion of a newly
formed volcaniclastic debris flow fan deposit and morphologic changes of the volcano’s
summit since the end of the eruption. Once an eruption has occurred, new deposits are
transformed by erosional processes such as wind, snowmelt and rain, tidal forces, and
additional volcanic activity. Remote sensing is a helpful and inexpensive tool that
periodically revisits a location to determine the type of change that is taking place.
Morphologic change to the volcano’s edifice is common after an eruption, and is
investigated here by the use of change detection. The amount of change taking place via
erosion and morphologic changes can have a significant impact on a nearby community.
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2.0 BACKGROUND
2.1 Study Area Description: Mount Cleveland Volcano
Mount Cleveland volcano is located on the western part of uninhabited
Chuginadak Island (Figure 2.1) at 52° 49’ N, 169° 57’ W (Miller et al., 1998). This
volcano was the source of explosive eruptions that lasted from February to March 2001.
It has erupted at least 20 other times in the past 230 years. Seven of these eruptions have
come within the last 20 years making it among the most active, annually, in the chain
(Table 2.1). Chuginadak is the Aleut legend for volcano goddess (Monaghan, 1982; and
Chadwick, 1989), similar to those of Pele in Hawai’i. Since the island (and possibly the
volcano) is referred to by this name, it is likely that the volcano has been active well
before 1774 when the first observed activity was documented. The volcano is about 8-8.5
km in diameter with an elevation of 1730 meters. The closest settlement is Nikolski,
about 75 km to the east on Umnak Island (Figure 1.1; Myers, 1990; Miller et al., 1998;
Dean et al., 2002a; Simpson et al., 2002, and McGimsey et al., 2004). Mount Cleveland
is also the only known volcano in Alaska to have produced an eruption resulting in the
death of one person, an American service member in 1944 stationed on the island during
World War II (Silk, 1944).
The main hazard posed by the volcano is from ash plumes, but lahars, viscous
basaltic andesite ‘a’a lava flows, and coarse pyroclastic debris frequently flow down the
volcano’s flanks (Dean et al., 2002a; and Dean et al., 2004). Though all of the activity
appears to come from the central summit crater, there are at least five andesitic to dacitic
(62.4 wt. % SiO2; Nicolaysen, K., written communication, 2004) lava domes surrounding
the volcano’s lower flanks (Figure 2.2). Four of these domes are located on the south and
southeast flanks. How they relate to Mt. Cleveland’s volcanic history is a question that
won’t be answered in this study, but could be the inspiration for future investigations.
There are also seven craters from four cinder cones located on the central isthmus of
Chuginadak Island. It is difficult to determine if these were related to Mt. Cleveland’s
activity or earlier volcanic activity (Figure 2.2). An area sketch from a Landsat 7
Enhanced Thematic Mapper Plus (ETM+) image acquired eight months before the initial
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Figure 2.1. Location map of Mount Cleveland. The upper map of Mt. Cleveland is a hill shaded relief DEM
from the Shuttle Radar Topography Mission (SRTM). Bad data sections of the SRTM were masked and
filled in with data taken from the USGS 1 degree DEM series following the steps outlined in Appendix C.
Pictures in the lower left show the volcano on (A) January 1, 2001 taken from the International Space
Station (image courtesy of Earth Sciences and Image Analysis Laboratory, NASA Johnson Space Center;
ISS001-E-5958 from http://eol.jsc.nasa.gov). A faint narrow gas or steam plume extends west-northwest
from Mt. Cleveland, and represents normal background activity at the volcano observed during several
field campaigns. (B) Photograph taken on August 5, 2003 of the western flank of the volcano from the new
volcaniclastic debris flow fan deposit from the 2001 eruptions. Lava flow levees are seen extending from
the summit in the center of the photograph. (C) The eastern flank of the volcano taken on July 21, 2004
from the eastern end of Applegate Cove on the northern side of the central isthmus.
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2001 eruption is shown in Figure 2.3, and displays the locations of the domes, cinder
cones, and the more predominant lava flows and lahars that have inundated the slopes in
the past. The eruption deposits from the 1994 eruption are still visible in Figure 2.3 with
a 0.65 km2 lahar extending down the southeast flank and other lahars with lava flows
down the south-southeast and southwest flanks.
2.2 The 2001 Eruptions
Although the Alaska Volcano Observatory seismically monitors 27, soon to be
29, active volcanoes in Alaska (as of May 2005), Mt. Cleveland is not one of these
volcanoes, thus remote sensing satellites provided the bulk of information for the 2001
eruptions. Dean et al. (2002a and 2004) and McGimsey et al. (2004) provide the current
chronology of the February to March 2001 eruption that is briefly summarized here. The
Alaska Volcano Observatory (AVO) received a photograph (Figure 2.4) from a pilot
after the initial emplacement of a lahar down the snow-covered southwest flank of Mt.
Cleveland. Though the photograph was taken on February 2, 2001, it was not received
and examined until February 19th after eruptive activity had commenced (McGimsey et
al., 2004). This feature was a lahar since there is no steaming at the edges like there
would be if this were a lava flow on snow. The existence of this lahar was later supported
in post-eruption analysis of two February 4, 2001 night time Advanced Very High
Resolution Radiometer (AVHRR) images showing faint thermal increases above
background levels (from -2.3° C to -0.2° C in backgrounds of -10° C to -9° C). These low
radiant temperatures also support the classification as a lahar. AVO’s original indication
of activity came during the course of routine monitoring on February 19, 2001. An
explosive eruption cloud and a large thermal anomaly at the summit were seen in an
AVHRR image from 1655 UTC, though the actual time of the observation was nearly
nine hours after the start of the eruption (Dehn, J., personal communication, 2005). Later
in the monitoring, the eruption is observed on Geostationary Operational Environmental
Satellite (GOES) imagery beginning at 1430 UTC. Pilot reports provided information that
the plume went from an early height of about 7.5 km up to 12 km. A few days later, the
thermal anomaly was seen in AVHRR imagery extending down the west flank of the
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Figure 2.4. Lahar on the southwest flank of Mount Cleveland. Photo taken on February 2, 2001 by pilot
Dean Cully, later provided to the Alaska Volcano Observatory.

volcano. This would be confirmed by September 2001 field observations as the main ‘a’a
lava flow and volcaniclastic debris flow deposits (Figure 2.5). Ash production from the
February 19th eruption was observed in satellite analysis for about 8 hours. Tremor-like
signals from short-period seismometers located on Makushin Volcano, 230 km northeast
of Mt. Cleveland on Unalaska Island, lasted for about 8.5 hours (Caplan-Auerbach et al.,
2004). The only observations of ash fall were from Nikolski during a period of 5 hours.
The ash cloud from February 19th was detected in GOES imagery for up to 48 hours after
the start of the eruption.
March 11, 2001 was the second explosive eruption lasting for about 3 hours. A
plume reached a height of 8 km and the lava flow continued down the west flank. The
lava was observed as a thermal anomaly in AVHRR data. The final explosive eruption
came on March 19, 2001 with a 6 hour duration. The plume reached a height of up to 9
km according to the National Weather Service (Dean et al., 2002a; Dean et al., 2004; and
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McGimsey et al., 2004). A small thermal anomaly was also observed on this day from the
eruption in AVHRR data. Elevated surface temperatures and low ash clouds were
periodically observed in satellite images throughout the rest of March to April 2001, but
these never lasted for more than a few days. The initial intent of this study is to expand
upon this brief chronology to constrain emplacement periods for the volcanic deposits.

Figure 2.5. Western 2001 ‘a’a lava flow and volcaniclastic debris deposits. The photo was taken in
September 2001 by Jon Dehn of AVO. The 3-Dimensional (3-D) image in the upper left inset, a true color
composite (Red-Green-Blue of 3-2-1 respectively) of the June 28, 2000 Landsat 7 ETM+ image draped
over the SRTM DEM, displays the entire volcano looking at the southwest flank of Mt. Cleveland. The
yellow box marks the area in the photo.
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3.0 PROJECT DATA
To complete the objectives of this thesis, remote sensing data and techniques are
utilized along with photographic and block measurement data from field observations.
Remote sensing data was acquired from several optical, thermal, and microwave sensors:
Landsat 7 Enhanced Thematic Mapper Plus (ETM+), Advanced Spaceborne Thermal
Emission and Reflection Radiometer (ASTER), Advanced Very High Resolution
Radiometer (AVHRR), Moderate Resolution Imaging Spectroradiometer (MODIS),
RADARSAT-1, and the Second European Remote Sensing Satellite (ERS-2). Figure 3.1
provides a visual representation of where these sensors operate in the electromagnetic
spectrum.
Observations from the sensors aid in improving the chronology of the eruption,
and to determine how much erosion and morphologic change has taken place at the
volcano since the eruption. The observations helped focus the period for the
volcaniclastic debris flow fan formation. The thermal flux and effusion rate estimates for
Landsat 7 ETM+, AVHRR, MODIS, and ASTER are useful to constrain the type of
activity. Landsat 7 ETM+, RADARSAT-1, and ERS-2 are used for investigating the
amount of erosion of the volcaniclastic debris flow fan.
Field observations from photographs (digital and analog) taken before and after
the eruption are also used for improving the eruption chronology. These photographs also
provide a reference for comparative analysis showing details of deformation on the
volcano not visible in the satellite data. In some cases, the photographs can be linked to
certain activity in satellite data providing “ground truth.” Measurement data from blocks
on the volcaniclastic debris flow fan were originally taken to aid an ASTER
hyperspectral technique that was found to be inconclusive for this type of surface. The
data from the block measurements is therefore used for a general classification of the
grain size and composition of the volcaniclastic debris flow fan deposit. This shed light
on the sequence of events for the formation of the volcaniclastic debris flow fan. By
looking at the stratigraphic relationship of the deposits, the presence of juvenile material,
and comparison to nearby deposits, different units and sources for the debris were
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determined. GPS elevation data was also taken during the collection of the block
measurements to provide a rough topographic map of the new volcaniclastic debris flow
fan deposit since no post eruption DEM is currently available.
3.1 Remote Sensing Data
The use of remote sensing offers an inexpensive alternative to the sometimes
costly and harsh conditions of fieldwork in the Aleutian Islands. With temporal
resolutions ranging from multiple times per day to 35 days, satellite sensors can provide
effective change detection of a location (barring poor weather conditions in some cases),
and collect information where first-hand observations are absent. The use of each sensor
in this study is briefly described below along with tabled information on the images that
were used.
3.1.1 Landsat 7 Enhanced Thematic Mapper Plus (ETM+)
Landsat 7 ETM+ is a high resolution sensor with a spatial resolution ranging from
15 to 30 meters in the visible and near to shortwave infrared wavelengths, and with 60
meters in the thermal infrared wavelengths (Appendix B, Table B.1). In this study the
visual, near infrared, and shortwave infrared data are used to locate deposits from the
eruption, constrain the chronology, follow the erosion of the volcaniclastic debris flow
fan deposit through time, and determine differences between other historic volcaniclastic
deposits around the volcano. The thermal infrared band data (10.4-12.5 µm) will be used
to locate 2001 deposits from the higher thermal signature from background that they
emit. This thermal data also aids in determining the type of activity occurring before,
during, and after the eruption using the methods of Harris et al. (1997a and 1997b) and
Dehn et al. (2002) for thermal flux and effusion rate estimation. Table 3.1 provides a list
of the individual satellite images used in this study ranging in time from June 28, 2000 to
November 22, 2001.
3.1.2 Advanced Spaceborne Thermal Emission and Reflection Radiometer
(ASTER)
ASTER is another high resolution sensor with spatial resolutions ranging from 15
to 30 meters in the visual to shortwave infrared wavelengths and 90 meters in the thermal
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Table 3.1. List of Landsat 7 ETM+ images used in this study. Data ordered from the United States
Geological Survey Landsat website (Appendix A). When observed, the type of activity in the form of a
plume (P) or thermal anomaly (TA) is indicated, as well as some location information on the anomalies.
Date
Path
Row
Image ID
Day/Night
Activity
28-Jun-00
79
23
L71079023_02320000628
Day
steam P, TA-Summit
11-Mar-01
79
23
L71079023_02320010311
Day
P, TA
8-Jun-01
78
23
L71078023_02320010608
Day
TA
22-Nov-01
79
23
L71079023_02320011122
Day
TA

infrared wavelengths (band 14; Appendix B, Table B.1). The sensor is used to gather
more information for the chronology of the eruption, and by using the thermal infrared
wavelengths, provides additional information on the type of activity from thermal flux
and effusion rate calculations. Table 3.2 provides a list of the ASTER scenes used in this
study, and range in time from June 28, 2000 to April 29, 2004.
3.1.3 RADARSAT-1 and Second European Remote Sensing Satellite (ERS-2)
The two C-band radar satellites of RADARSAT-1 and ERS-2 provide high spatial
resolution data within the microwave (5.6 cm) wavelength region of the spectrum
(Figure 3.1). This is useful for change detection for the erosion rate of the volcaniclastic
debris flow fan deposit and to determine any morphologic change of the summit region.
The advantage of the radar satellites is that they can penetrate clouds, and are only
slightly affected by other weather conditions. Another well-known use of radar data is to
produce interferograms between two repeat passes over the same location in order to
determine the amount of deformation over the area. This technique, however, is time
consuming, beyond the scope of this study, and has already been produced by Lu et al.
(2003). Only semi-quantitative analysis of the radar data for changes in area size was
done in this study. Tables B.2 (Appendix B) and 3.3 display the characteristics of these
two sensors and a list of the individual satellite images used in this study respectively.
The time frame of the radar data runs from November 13, 1999 to December 21, 2003
and is mostly made up of post eruption data.
3.1.4 Advanced Very High Resolution Radiometer (AVHRR)
AVHRR has been a very reliable sensor used by the Alaska Volcano Observatory
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Table 3.2. List of ASTER images used in this study. Night time images consist of only the thermal infrared
bands of data. Data downloaded from the Earth Observing System Data Gateway website (Appendix A).
When observed, the type of activity in the form of a plume (P; st = steam plume) or thermal anomaly (TA)
has been indicated, as well as some location information on the anomalies. The “?” in the activity means
questionable observations.
Date
Image ID
Day Night
Activity
28-Jun-00
AST_L1A.002:0006282250430012280697
X
st P, TA
6-Nov-01 AST_L1B_003_11062001224000_12062003125621
X
P?, TA
8-Apr-02
AST_L1B.003:2006580707
X
TA
8-Oct-02
AST_L1B_003_10082002090517_12202002170339
X
TA-Summit
8-Oct-02
AST_L1B_003_10082002090525_12202002183435
X
TA-Summit
12-Jan-03 AST_L1B_003_01122003090513_01282003141730
X
TA
12-Jan-03 AST_L1B_003_01122003090522_01282003141800
X
TA
13-Feb-03 AST_L1B_003_02132003090523_03112003173440
X
TA-Summit
13-Feb-03 AST_L1B_003_02132003090532_03112003191421
X
TA-Summit
29-May-03 AST_L1B_00305292003085840_06162003091352
X
TA
5-Dec-03
AST_L1B_00312052003091133_12192003134717
X
TA-Summit
29-Apr-04
AST_L1B_00304292004085821_05102004121311
X
TA-Summit

(AVO) for the near real-time monitoring of volcanoes from space (Harris et al., 1997b;
Dean et al., 1998; Dehn et al., 2000; Schneider et al., 2000; Wright et al., 2002; Dean et
al., 2002a; Dean et al., 2002c; and Dean et al., 2004). With its capability at polar latitudes
of taking multiple images of the Aleutian Islands each day, AVHRR is used for the
detection of thermal anomalies and ash plumes/clouds during volcanic eruptions. This
makes AVHRR critical in improving the chronology of the 2001 eruption. Further, when
processing the 1.1 km thermal data (bands 3 and 4; Table B.3, Appendix B), thermal
flux and effusion rate estimates help determine the type of activity. Tables B.3
(Appendix B) and 3.4 display the characteristics of the sensor and a list of the individual
satellite images used in this study respectively. Though the archive of AVHRR data
maintained by AVO through the collaboration with the University of Alaska Fairbanks
Geophysical Institute dates back to 1993 (Dehn et al., 2000; and Schneider et al., 2000),
these data used for this study focuses on the period from only January 27, 2001 to March
24, 2001.
3.1.5 Moderate Resolution Imaging Spectroradiometer (MODIS)
MODIS is a sensor that has been operational since 1999 on the NASA Terra

32
Table 3.3. List of RADARSAT-1 and ERS-2 images used in this study. The Beam column for RADARSAT-1
indicates the beam setting for the image similar to the inset diagram in Figure 4.1 (ST = Standard Beam).
Data obtained through the Alaska Satellite Facility website (Appendix A).
Satellite
Date
Image ID
Pass Type
Beam
RADARSAT-1
13-Nov-99 R121011318G1S003 Descending
ST6
ERS-2
10-Jul-00
E227295318G1S004 Descending
RADARSAT-1
31-Mar-01 R128214318G1S002 Descending
ST6
RADARSAT-1
24-Apr-01 R128557318G1S002 Descending
ST6
RADARSAT-1
18-May-01 R128900318G1S002 Descending
ST6
RADARSAT-1
11-Jun-01 R129243318G1S002 Descending
ST6
RADARSAT-1
5-Jul-01
R129586318G1S002 Descending
ST6
RADARSAT-1
22-Aug-01 R130272318G1S002 Descending
ST6
RADARSAT-1
15-Sep-01 R130615318G1S002 Descending
ST6
RADARSAT-1
9-Oct-01
R130958318G1S002 Descending
ST6
RADARSAT-1
2-Nov-01 R131301318G1S002 Descending
ST6
RADARSAT-1
20-Dec-01 R131987318G1S002 Descending
ST6
RADARSAT-1
13-Jan-02 R132330318G1S002 Descending
ST6
RADARSAT-1
6-Feb-02
R132673318G1S002 Descending
ST6
RADARSAT-1
2-Mar-02 R133016318G1S002 Descending
ST6
RADARSAT-1
19-Apr-02 R133702318G1S002 Descending
ST6
RADARSAT-1
6-Jun-02
R134388318G1S002 Descending
ST6
RADARSAT-1
24-Jul-02 R135074318G1S004 Descending
ST6
RADARSAT-1
17-Aug-02 R135417318G1S005 Descending
ST6
RADARSAT-1
10-Sep-02 R135760318G1S002 Descending
ST6
RADARSAT-1
4-Oct-02
R136103318G1S002 Descending
ST6
ERS-2
1-Dec-02
E239820318G1S004 Descending
ERS-2
5-Jan-03
E240321318G1S003 Descending
ERS-2
9-Feb-03
E240822318G1S002 Descending
RADARSAT-1
28-May-03 R139476318G1S007 Descending
ST2
RADARSAT-1
1-Jun-03
R139533318G1S002 Descending
ST6
RADARSAT-1
19-Jul-03 R140219318G1S011 Descending
ST6
RADARSAT-1
5-Aug-03 R140462318G1S010 Descending
ST6
RADARSAT-1
12-Aug-03 R140562318G1S011 Descending
ST6
RADARSAT-1
5-Sep-03
R140905318G1S011 Descending
ST6
RADARSAT-1
29-Sep-03 R141248318G1S003 Descending
ST6
RADARSAT-1
16-Oct-03 R141491318G1S003 Descending
ST6
RADARSAT-1
23-Oct-03 R141591318G1S003 Descending
ST6
ERS-2
16-Nov-03 E244830318G1S002 Descending
ERS-2
5-Dec-03
E245102318G1S003 Descending
ERS-2
21-Dec-03 E245331318G1S002 Descending

33

34
platform and since 2002 on the NASA Aqua platform (Wright et al., 2002). This sensor
images the Aleutian Islands 2-4 times per day in the visible through thermal wavelengths.
The spatial resolution of the sensor ranges from 250 meters in the visible wavelengths to
1 kilometer in the thermal wavelengths (Appendix B, Table B.3). The thermal bands
(primarily 21, 22, and 31) are used to estimate the thermal flux and effusion rate in order
to determine the type of activity. MODIS will also be utilized to improve the 2001
eruption chronology. Table 3.5 provides a list of the individual satellite images used in
this study ranging from January 29, 2001 to March 24, 2001. Another image from
November 6, 2001 was also investigated for activity since a possible steam plume was
observed on an ASTER image on that date. This later image was used in the chronology
of continued activity at the volcano since the eruptions earlier in 2001.
3.1.6 Shuttle Radar Topography Mission (SRTM)
The use of SRTM data in this study is primarily for the production of a digital elevation
model (DEM) of the volcano to display topographic relief information in 3-Dimension
(3-D) view. Table B.2 (Appendix B) provides information about the SRTM mission of
February 11-22, 2000. These data used in this study were acquired before the 2001
eruptions, thus changes from the eruption and newly formed volcaniclastic debris flow
fan deposit are not represented. The SRTM DEM was first corrected for the geoid height
(to improve the elevation accuracy) then bad data values were replaced with data from
the Samalga West 1:250,000 scale 1 degree DEM from the United States Geological
Survey (USGS; see Appendix C for an example of how this was done). Satellite images
from the sensors above are then draped over the DEM to display a 3-D view of the
volcano. Using the DEM for visible and near infrared images aids in showing changes in
slope or the addition of new land, such as in the case of the new volcaniclastic debris
flow fan deposit. For thermal data, the use of the DEM shows more precisely, where
activity is confined on the volcano (i.e. erosion channels or flat surfaces).
3.2 Field Observations
Following the February to March 2001 eruption of Mt. Cleveland, AVO scientists
conducted their first preliminary field season in September 2001. The focus of this
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Table 3.5. List of MODIS images used in this study. When observed, the type of activity in the form of a
plume (P) or thermal anomaly (TA) is indicated. If activity is possible it is prefixed by “pos,” and if a
questionable observation it is suffixed by “?.” The term “faint” is used when the thermal anomaly is only
within 5 degrees of the background temperature. Data were ordered and downloaded from the Earth
Observing System Data Gateway website (Appendix A).
Date
Image ID
Day Night
Activity
29-Jan-01 MOD021KM.A2001029.2250.004.2002350074357
X
pos TA
12-Feb-01 MOD021KM.A2001043.0930.003.2001332064647
X
TA
19-Feb-01 MOD021KM.A2001050.2310.003.2001360174728
X
P, TA
21-Feb-01 MOD021KM.A2001052.0925.003.2001358175039
X
P?, TA
21-Feb-01 MOD021KM.A2001052.2255.003.2001363225939
X
TA
1-Mar-01 MOD021KM.A2001060.0835.003.2001247232728
X
TA?
11-Mar-01 MOD021KM.A2001070.0915.004.2003067075849
X
P?, TA
11-Mar-01 MOD021KM.A2001070.2245.004.2003067144833
X
P, TA
13-Mar-01 MOD021KM.A2001072.0900.003.2001183031115
X
TA
15-Mar-01 MOD021KM.A2001074.2220.003.2001184233419
X
TA
16-Mar-01 MOD021KM.A2001075.0930.003.2001185064117
X
TA
18-Mar-01 MOD021KM.A2001077.0920.003.2001186173252
X
TA
19-Mar-01 MOD021KM.A2001078.2155.003.2001187171820
X
P
20-Mar-01 MOD021KM.A2001079.0905.003.2001187222513
X
P?, TA
20-Mar-01 MOD021KM.A2001079.2240.003.2001188095117
X
TA
21-Mar-01 MOD021KM.A2001080.0810.004.2003012152250
X
TA
21-Mar-01 MOD021KM.A2001080.0950.004.2003012161019
X
TA
21-Mar-01 MOD021KM.A2001080.2320.004.2003069140100
X
TA?
22-Mar-01 MOD021KM.A2001081.0855.004.2003068171417
X
TA
22-Mar-01 MOD021KM.A2001081.2225.004.2003068231242
X
faint P, TA?
23-Mar-01 MOD021KM.A2001082.2310.004.2003069154039
X
TA
24-Mar-01 MOD021KM.A2001083.0840.004.2003069193203
X
TA
24-Mar-01 MOD021KM.A2001083.1020.004.2003069215626
X
TA?
6-Nov-01 MOD021KM.A2001310.2240.004.2003132151317
X
P?

fieldwork was to gather data on the 2001 eruption deposits on the western flank by
sampling the deposits, acquiring thermal images from the Forward Looking Infrared
Radiometer (FLIR) instrument, and to photograph the deposits for later analysis. Later in
September 2002, fieldwork was conducted for use in the making of a hazard report from
AVO on the 2001 eruption, and the production of a detailed geologic map of the volcano.
Work during this time frame was limited to the eastern half of the volcano. Fieldwork
was conducted in early August 2003 revisiting the western half of the volcano, but due to
weather, only the volcaniclastic debris flow fan deposit and some sections on the lower
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northwest flank were investigated. Though poor weather conditions limited the amount of
work that could be done, a detailed mapping of the 2001 volcaniclastic debris flow fan
deposit was completed and digital photographs of the deposits were taken for analysis.
The most recent field season in July 2004 was used to gather mapping information for the
geologic map, perform ground truthing of the satellite data, and gather more samples for
geochemical and petrologic analysis.
3.2.1 Field Photographs and Other Photographs and Images
The field photographs (both digital and analog) taken in 2001 before and after the
eruption are compared to the digital field photographs taken in 2002 to 2004. These
photographs are used to gather more detailed information about the chronology of the
eruption. The photos are also used to provide ground truth for satellite images and for
comparison to other field observations. Several panoramic digital photographs were taken
in the 2003 field season to show the layout of the fan deposits. Other digital photographs
taken in August 2003 were of several breadcrust bombs and ‘a’a blocks comprising the
volcaniclastic debris flow fan deposit. These photographs aid in the stratigraphic
characterization of the deposit. Other digital photographs and images taken by outside
observers and astronauts on the International Space Station were also used to aid the
chronology of events.
3.2.2 2003 Field Measurements
In order to gain more insight on the grain size composition and stratigraphy of the
volcaniclastic debris flow fan deposit, block measurements were made in the 2003 field
season. The measurement was confined to two different block types found on the surface
of the volcaniclastic debris flow fan deposit: breadcrust bombs and ‘a’a blocks (Figure
3.2). The methodology of these block measurements is detailed in the next section.
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Figure 3.2. Breadcrust bomb and ‘a’a block photographs. (A) Breadcrust bomb measuring 3.3 m by 3.0 m
located near the main 2001 lava flow on the volcaniclastic debris flow fan deposit. (B) ‘A’a block
measuring 9.1 m by 5.0 m located near the coastal northwestern portion of the volcaniclastic debris flow
fan deposit. Both photos were taken in August 2003.
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4.0 METHODOLOGY
Along with aiding the chronology updates, optical remote sensing data were used
to calculate thermal flux and effusion rates following the methods of Harris et al. (1997a
and 1997b) and Dehn et al. (2002) for the sensors of Landsat 7 ETM+, AVHRR, MODIS,
and ASTER. RADARSAT-1, ERS-2, and Landsat 7 ETM+ data were used to follow the
erosion of the newly formed volcaniclastic debris flow fan deposit, and track the
morphologic changes to the summit region based on semi-quantitative area estimations.
Block measurement data from the 2003 field campaign was used with the information
from the chronology update and the thermal remote sensing data to investigate the
formation of the volcaniclastic debris flow fan deposit.
Two other techniques were attempted on the data, but were eventually thrown out
due to the inability of the techniques to characterize the compositional makeup and age of
the deposits. A hyperspectral processing technique developed by Ramsey and
Christensen (1998), later modified by Ramsey and Fink (1999), and recently used by
Ramsey and Dehn (2004) for the ASTER sensor was not able to pick up slight
differences in the grain size variations of the volcaniclastic debris flow fan deposit. This
technique was developed to do vesicularity mapping on lava domes and was not ideal for
the complex textures of pyroclastic deposits. Their method involves using five thermal
infrared bands of ASTER to examine the linear combination of two end-members (glass
and vesicles) deconvoluted through a least-squares regression to produce a distribution
percentage map.
The second technique was an attempt at backscatter characterization following the
method used in Dean et al. (2002b) and commented on in Lu et al. (2004) using
RADARSAT-1 and ERS-2 data. The technique presented by Dean et al. (2002b)
associated the backscatter of radar images to known lava flows observed in the field.
Known lava flows were outlined and the backscatter of each was compared to others
acquired from other dates. With time, lava shows less backscatter as it weathers. The
authors also produced spectral transects along each of the flows to determine if any
differences could be observed. Dean et al. (2002b) and Lu et al. (2004) focused on
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Westdahl Volcano on Unimak Island, Alaska, for better characterization between
different ages of lava flows. The lava flows on Mt. Cleveland’s steep slopes made this
technique more difficult to use for this study when compared to the more gentle slopes of
where the lava flows were located on Westdahl. Additionally, layover affects and
different look angles from the radar signal at Mt. Cleveland prevented the use of this
technique. Some of the older lava flows that were to be compared with the 2001 lava
flow on the west flank fell within the affected regions and had slight differences in look
angles that prevented proper comparison. Figure 4.1 illustrates the affect of the layover
and shadowing on the Mt. Cleveland area.
4.1 Chronology Update
A detailed description of the chronology was established using all known
information about the 2001 eruptions from published data, volcano monitoring
observations from the AVO remote sensing database, field and other contributed
observations, and satellite images. The chronology focuses on the periods of the eruption
from January 2001 to March 24, 2001, but continued to include activity into early August
2004. Summaries from the previous studies of Dean et al. (2002a, 2002c, and 2004),
Simpson et al. (2002), and Watson et al. (2004) provide baseline information for the
eruption periods. The improvement of the chronology constrained the timing of
emplacement for the volcaniclastic debris flow fan deposit. The chronology is aided by
the results of the sections below on eruptive activity, erosion of the fan deposit, and
morphologic changes of the summit. The addition of field observations and newly
acquired satellite images show that the volcano has continued to be active for several
years after the eruption, though at a subdued level.
4.2 Eruptive Activity
Constraining the eruptive activity for the February to March time frame is done
following the developed techniques of Harris et al. (1997a and 1997b) and Dehn et al.
(2002). Harris et al. (1997a and 1997b) provide two and three thermal component
equations to calculate the portions of pixels that are made up of a hot and cold component
as well as a portion of the pixel made up by a crust on the lava’s surface. These pixel
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Figure 4.1. Example of layover and shadowing in radar data. This RADARSAT-1 image is from March 31,
2001. The satellite flight path and look direction is indicated. In the inset diagram are examples of (A) the
layover effect from the eastern part of the volcano producing more backscatter due to an overall lower
incidence angle of the radar beam, and (B) the incidence angles (θ) of the radar satellites used in this
study. The S6 (41° to 46°) and S2 (24° to 31°) labeled angles are the ranges of the two standard beam
incidence angles for RADARSAT-1. All but one image of the RADARSAT-1 data set was acquired at S6
angles. The purple line labeled as ERS-2 is the incidence angle of 23° that the ERS-2 sensor acquires
images. The lower the incidence angles, the less layover effect.

portions are then used to estimate the area of the lava, calculate the thermal flux from this
area, and use the thermal flux to calculate effusion rate. Though Harris et al. (1997a and
1997b) developed these equations for the AVHRR sensor, they were applied to Landsat 7
ETM+, MODIS, and ASTER data. Dehn et al. (2002) used the Harris et al. (1997a and
1997b) equations for thermal flux and effusion rate estimates, but also use these data in
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time series to show how the activity is changed through the eruption. This study uses this
time series, along with a plot of the radiant temperature values through time, to constrain
the type of activity at the volcano.
4.2.1 Thermal Flux
Thermal flux estimates from thermal infrared satellite data have been developed
and refined based on the work of Dozier (1981), Harris et al. (1997a, 1997b, 1998, 1999,
2003, and 2004). Before producing the thermal flux estimates, however, the satellite data
is transformed to radiant brightness temperature at the sensor. There are several ways to
do this depending on which sensor is used. Most revolve around the solution of the
Planck equation (1) for the temperature value, otherwise known as the inverse Planck
equation (2) after Gupta (2003). Both equations are used for thermal infrared band data.

L(λi , T ) =

T=

C1
⎡ ⎛⎜⎜ C2 ⎞⎟⎟ ⎤
5
λi π ⎢e ⎝ λiT ⎠ − 1⎥
⎢
⎥
⎣
⎦
C2

⎡⎛ C
λi ln ⎢⎜ 5 1
⎢⎣⎜⎝ λi πLλi

⎞ ⎤
⎟ + 1⎥
⎟ ⎥
⎠ ⎦

(1)

(2)

Table 4.1 provides data on the variables used for all of the thermal equations in this study

along with some values used for constants and assumptions. Appendices D and E display
several example calculations for each of the sensors used in this study beginning at the
pixel area determination (only for AVHRR) and temperature solution while ending at the
calculation of the total thermal flux and effusion rate.
The entire calculation of thermal flux is based on the simultaneous solution of a
two component model (Dozier, 1981; and Harris et al., 1997a) using two thermal infrared
bands of data (i.e. the dual band method). Equations (3) and (4) display the equation of
two separate thermal bands. The bands used in this study are bands 3 and 4 in AVHRR
data, bands 21, 22, and 31 in MODIS data, band 6 (low gain setting) in Landsat 7 ETM+
data, and band 14 in ASTER data (see Table 4.2 for the central wavelengths of each
band). The hot pixel portion (p) and the temperature of the hot portion of the pixel (Th),
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Table 4.1. Equation variables and values used in this study. The middle number for the variables of lava
temperature, emissivity, lava density, and crystal fraction are the primary assumed value for each.
Additional values for these four variables are for determining error in the thermal flux and effusion rate
calculations.
Variable
Explanation
Value Used
Units
At sensor radiance at band i wavelength and
L(λi,T)
From image
W/m2µmst
temperature
At sensor radiance at band j wavelength and
L(λj,T)
From image
W/m2µmst
temperature
At sensor radiance at band i wavelength and
L(λi,Th)
From image
W/m2µmst
lava temperature
At sensor radiance at band j wavelength and
From image
W/m2µmst
L(λj,Th)
lava temperature
At sensor radiance at band i wavelength and
L(λi,Tb)
From image
W/m2µmst
background temperature
At sensor radiance at band j wavelength and
L(λj,Tb)
From image
W/m2µmst
background temperature
λi
Wavelength of band i
µm
Table 4.2
λj
Wavelength of band j
µm
Table 4.2
T
Radiant brightness temperature at sensor
Calculated
K
1073.15, 1273.15,
K
Th
Lava temperature
1473.15
Tb
Background temperature
From image
K
C1

Constant 1

3.741832x108

Wµm4/m2

C2

Constant 2

1.438786x104

µmK

Lλi

At sensor radiance at band i wavelength

From image

W/m2µmst

ph

Hot pixel portion

Calculated

None

A

Area of the hot pixel portion

Calculated

m2

At

Total pixel area

Calculated

m2

qc
qr
Qtotal

Convective thermal flux
Radiative thermal flux
Total thermal flux

Calculated
Calculated
Calculated

W
W
W

hc
δT
σ

10
Calculated
5.67x10-8

W/m2K
K
W/m2K4

0.89, 0.93, 0.99

None

Er

Convective heat transfer coefficient
Change in temperature
Stefan-Boltzmann constant
Emissivity of basaltic andesite (from
ASTER spectral library in Appendix A)
Effusion rate

Calculated

m3/s

ρ

Lava density

2550, 2600, 2700

kg/m3

ε

Cp
f
cL

Lava heat capacitance
1256.04
Crystal fraction
0.005, 0.03, 0.1
Latent heat of crystallization of lava
355878.00
Remember that 1 W = 1 J/s or 1 J = 1 Ws, and st = steradian

J/kgK
None
J/kg
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Table 4.2. Central wavelengths of thermal bands used in this study.
Sensor
Band #
Central Wavelength (µm)
3
3.740
AVHRR
4
10.800
21
3.959
MODIS
22
3.959
31
11.030
Landsat 7 ETM+
6.1
11.450
ASTER
14
11.300

must be solved for using the simultaneous solution. The studies of Harris et al. (1997a
and 1997b) also take into account solving for another component, the crust of the lava,
while Wright and Flynn (2003) postulate that 5-7 components are needed for proper
thermal studies of lava flows. Since no valid assumptions for Mt. Cleveland are available
for these types of solutions, the crustal and additional components were not solved for
this study, providing a first order approximation of the thermal flux.
L(λi , T ) = p h L(λi , Th ) + (1 − p h )L(λi , Tb )

(3)

L(λ j , T ) = p h L(λ j , Th ) + (1 − p h )L(λ j , Tb )

(4)

Dozier (1981), Harris et al. (1997a and 1997b), and Wright et al. (2001a and 2001b)
provide for another solution to find the hot pixel portion by variations in equation (5). For
this study, equation (5) is used to find the hot pixel portion by using AVHRR band 3 and
MODIS band 22. When these two bands are saturated, however, the hot pixel portion was
found by using the AVHRR band 4 and MODIS band 21 data. The data from band 6 of
Landsat 7 ETM+ and band 14 of ASTER are also solved using equation (5), but no
alternate bands from these sensors are available if saturation occurs. The results from
equation (5) are then used in equation (6) to find the area of the hot pixel portion. Wright
et al. (2001b) stipulate that the method behind equation (5) can break down when lava
flows pond. With the possible exception of in the crater, the steep slopes of Mt.
Cleveland make it difficult for any ponding of lava flows to occur, thus the use of
equation (5) is valid for this study.
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ph =

[L(λi , T ) − L(λi , Tb )]
[L(λi , Th ) − L(λi , Tb )]

A = p h At

(5)
(6)

Once the area of the hot pixel portion was determined, the convective thermal flux
(7) and the radiative thermal flux (8) are added to produce total thermal flux (9). Another
thermal flux term for conduction (qk) would also need to be added into the total thermal
flux. Harris et al. (1998) show that for Hawaiian ‘a’a lava flows, the contribution to total
thermal flux from qk is only 10-30% during the first 2 hours of emplacement. They also
state that qk should not be ignored for this reason, but because the conductive thermal
flux is an order of magnitude less than the convective thermal flux, and two orders of
magnitude less than the radiative thermal flux, it was not used for the satellite data in this
study (Dehn, J., personal communication, 2005). The addition of the conductive thermal
flux would only serve to increase the overall trend in the resulting total thermal flux.
Following Harris et al. (2004) this study assumes that all the heat lost at the surface is
from qr and qc, which equal qk through the flow. The conductive thermal flux is only used
later in section 6.2 for investigating the interaction between the lava and snow, because it
is more of an influence to melting the snow. Values for the emissivity (ε) in equation (8)
came from the ASTER spectral library run by the Jet Propulsion Laboratory website in
Appendix A. The spectral library data was originally in percent reflectance values (%R),

but was converted for this study to an emissivity value using equation (10).
q c = hc AδT

(

q r = σεA Th4 − Tb4

(7)

)

Qtotal = q r + q c
⎛ %R ⎞
⎟
⎝ 100 ⎠

ε = 1− ⎜

(8)
(9)
(10)

The use of the thermal flux is to understand the amount of energy that is produced by the
volcano during active periods.

4.2.2 Effusion Rate
Effusion rate (sometimes referred to as eruption rate) is calculated to provide an
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estimate for how much eruptive material is being produced with time. Equation (11) is
used to determine the total effusion rate (m3/s) using the results of the thermal flux
calculation (Pieri and Baloga, 1986; Harris et al., 1997a; Harris et al., 1997b; Wright et
al., 2001b; and Dehn et al., 2002).

Er =

Qtotal
ρ (C p δT + fc L )

(11)

The values for the variables are provided in Table 4.1, and example calculations are
presented in Appendix E. The assumptions include density, which was found by taking
the average value for basaltic andesite from Spera (2000), and crystal fraction, which is
similar to that used by Harris et al. (1998) on lavas from Kilauea volcano in Hawai’i.
Values for the heat capacitance and latent heat of crystallization were the same as those
used by Crisp and Baloga (1994) on lava flows from Mauna Loa volcano in Hawai’i.
4.3 Erosion of the Volcaniclastic Debris Flow Fan Deposit
A semi-quantitative method is used to measure the erosion of the volcaniclastic
debris flow fan deposit using monthly to bimonthly radar imagery acquired from March
31, 2001 to October 23, 2003. The images used are from the RADARSAT-1 sensor, but
three gaps were filled with ERS-2 images. The images are registered so a rough
comparison between each image could be made (Figure 4.2 (A)). Through time, there
was redeposition of material. This redeposited material was included in the area
estimates. A similar technique was used on Landsat 7 ETM+ data, but these data were not
used since the three data points did not significantly improve the erosion estimates. As
observed in Figure 4.1, the viewing angle of the RADARSAT-1 data produced larger
area estimates than the ERS-2 images. This resulted in using only the larger
RADARSAT-1 data set to be consistent. Another distortion to the radar data was from
the unsuccessful terrain correction. This distortion, along with the viewing angle adds a
few meters of additional area. Error from this distortion was beyond the scope of this
study since only a first order approximation was produced.
4.4 Morphologic Changes of the Summit
The same semi-quantitative method and time period for area determination on the
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volcaniclastic debris flow fan deposit erosion was used to investigate the area change to
the summit crater. Figure 4.2 (B) displays an example of the crater area estimate at the
summit of the volcano. Unlike the area estimates for the erosion of the volcaniclastic
debris flow fan deposit, the area of the crater is at best a rough estimate since there were
more geometric distortions in the area outlines. Since the radar data could not be properly
terrain corrected, the crater region had more layover effects and stretching. At times, it
was more difficult to determine if certain parts of the crater were the crater rim or layover
backscatter.
4.5 2003 Field Measurement Data
To produce a description of the depositional stratigraphy of the volcaniclastic
debris flow fan deposit, block measurements were taken by using a grid for the data
collection (Figure 4.3) mapped from a Landsat 7 ETM+ image acquired on November
22, 2001. This grid was created by taking the position of the center of each 30 meter pixel
in the Landsat 7 ETM+ image. The location data for these pixel centers were entered into
a global positioning system (GPS) instrument for use in the field to locate the center of
each grid point on the fan deposit. Originally, 151 grid points were collected for use in
the field. The number of grid points was modified to 61 after the field team arrived on
scene because the other grid points were not located on the fan deposit. Another
modification was done to alternate data collection from grid points in order to speed up
the process since weather became a factor in how long the field party could stay on the
island. Table 4.3 provides information on the data collected from the grid points. At each
grid point, the general data of depositional facies (breadcrust bomb (BCB) or ‘a’a block
(AB)) within the grid point and elevation were taken. When the grid point fell under the
2001 ‘a’a lava flow this was also noted. At the main grid points for the data collection
about a 2 meter radius from the center of the grid point was marked off - the exception
being grid point 53 that had a 5 meter radius due to being near the lava flow. Within the
radii of these main grid points all blocks that had exposed lengths greater than 1 foot (~35
cm) were measured and their type was documented. The measurements were initially
taken in feet and inches and later converted to meters.
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Figure 4.3. Volcaniclastic debris flow fan deposit grid point map. (A) Map taken from the lower left
Landsat 7 ETM+ (5-4-2) satellite image of November 22, 2001 (image interactively enhanced with a linear
2% enhancement and 3x3 high pass filter to bring out details). The grid focuses on fan deposit (in red
inside yellow box) on the western flank of Mt. Cleveland. Each square represents an enlargement of each
30 meter pixel from the satellite image (not drawn to scale). The GPS reference numbers in some squares
represent the central part of pixels that were initially determined to be on the fan deposit. Blank squares
depict additional pixels originally not considered as being on the volcaniclastic debris flow fan deposit, but
were included only in the facies description after being observed in the field. (B) Same grid point map
colorized to depict the composition of the depositional facies for each pixel.
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5.0 RESULTS

5.1 Chronology
The chronology of the 2001 eruption has been updated with the results of the
satellite data, field photographs, and field observations presented below, as well as being
summarized in Figure 5.1. The initial signs of renewed activity at Mount Cleveland came
from the February 2nd photo from pilot Dean Cully (Figure 2.4), though it was not
received and viewed by AVO until after the February 19th eruption (Dean et al., 2002a;
Dean et al., 2004; and McGimsey et al., 2004). As also indicated in Dean et al. (2002a
and 2004), there was a thermal anomaly detected at the summit of the volcano in night
time AVHRR images on February 4th (1620 UTC and 1728 UTC). Though observed in
the late afternoon, there was a faint 1 pixel thermal anomaly (-4.2° C pixel integrated
radiant temperature in a background of -10° C) observed in an AVHRR image on
February 6th (0350 UTC). On February 12th (UTC) there was a thermal anomaly detected
in a night time AVHRR image (0402 UTC) and a night time MODIS image (0930 UTC)
with the later showing a 1 pixel anomaly on the southeast side of the summit (Dean et al.,
2004). There were three other MODIS images (February 15, 17, and 18 UTC) that
indicated possible thermal anomalies, though after further analysis the anomalies were
determined to be solar reflection off of clouds over the volcano, thus not of volcanic
origins.
The first initial eruption image came from a Geostationary Operational
Environmental Satellite (GOES-10) image at 1430 UTC. However, Figure 5.2 displays
the first higher resolution AVHRR image that was received at 1643 UTC on February
19th (though reported as 1655 UTC by Dean et al., 2002a and Dean et al., 2004, which is
the AVO processing time of the subsectioned image). The AVHRR image displayed a
bidirectional plume (to the northwest and southeast) from a shear zone at about 6 km
altitude (Dean et al., 2002a; and Dean et al., 2004) as well as a thermal anomaly.
Simpson et al. (2002) indicate that this shear zone was at an altitude of almost 9 km from
the radiosonde data of stations near and downwind from the volcano (the closest stations
being Adak at 470 km west-southwest, St. Paul Island at 480 km north, and Cold Bay at
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540 km east-northeast). A MODIS image from 2310 UTC on the 19th of February also
depicted the thermal anomaly and the now elongated plume extending to the northeast
and arcing to the northwest (Figure 5.2). The southeast part of the plume was barely
visible in this MODIS image, but was soon entrained in an extra-tropical low pressure
system over the Gulf of Alaska. This made it more difficult to discriminate from
surrounding cloud cover (Simpson et al., 2002; and Dean et al., 2004). The thermal
anomaly and northwest extending ash cloud were also observed in two consecutive
AVHRR images on February 20th (0242 UTC and 0418 UTC), and three consecutive
AVHRR images (1619 UTC, 1736 UTC, and 1800 UTC) and two MODIS images (0925
UTC and 2255 UTC) on February 21st.
Though pilot reports of the eruption ash cloud were being received from February
19th till the end of it’s dispersion on February 22nd in GOES-10 data (Simpson et al.
2002), the first photos of the volcano were taken by pilot Burke Mees on February 21st
Alaska Standard Time (AST). Analysis of his photos reveals the new volcaniclastic
debris flow fan deposit extending into the ocean on the western side of the island (Figure
5.3). Also observed in Figure 5.3, the ‘a’a lava flow extends only half way down the

western flank on top of previous volcaniclastic deposits (McGimsey et al., 2004). The
edges of the volcaniclastic debris flow fan deposit are steaming at the contact with the
water indicating that the deposit is hot. From field photographs taken by Jon Dehn in
September 2001 the steam is from fumaroles created by the seawater-hot material
interaction (Figure 5.4), and is still warm after seven months. Due to erosion, the
fumaroles in Figure 5.4 are located only tens of meters in from the fan’s edge, but would
have been further in from the edge seven months earlier. The fumaroles in Figure 5.4
were not as extensive as the fumaroles located at the original edge from February 2001
(Dehn, J., personal communication, 2005). The formation mechanism of this
volcaniclastic debris flow fan deposit is subject to debate, but discussed later in section 6.
A daytime MODIS image at 2255 UTC on February 21, 2001 revealed the likely
ash deposition area from the February 19th eruption (Figure 5.5). Dean et al. (2002a and
2004) state that Nikolski received about 5 hours of ash fall deposition associated with this
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Figure 5.3. The 2001 eruption deposits on the western flank. In these two photos taken by pilot Burke Mees
(© February 21, 2001) the extent of the eruption deposits as of February 21st (in solid red and yellow lines)
is observed. The furthest extent of the 2001 ‘a’a lava flow is in a dashed red line, and the seasonal lahar
channel is in a dashed yellow line. Also visible in the inset photo (A) is the steam at the edges of the
volcaniclastic debris flow fan deposit that entered the ocean from the fumaroles interacting with water (see
Figure 5.4).

eruption. A clear discoloration seen on the snow east of Nikolski in Figure 5.5 marks the
ash deposition since at this elevation there is no snowmelt in February 2001. For
comparison, other areas of equal elevation on Umnak Island still have brighter snow not
covered with ash. The thermal activity at the volcano continued to be observed in
AVHRR satellite imagery on February 22nd (4 images) and February 26th (3 images). On
February 27th, one AVHRR image (1649 UTC) displayed a thermal anomaly. A MODIS
image on March 1st (0835 UTC) displays a faint thermal anomaly (-3.3° C in a
background of -6° C) on the west flank around the location of the fan deposit. The last
image to have a thermal anomaly observed before the second eruption was on March 7th
at 1713 UTC. This is a 4 pixel anomaly at the summit and extended down the west flank,
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Figure 5.5. Ash fall deposition from February 19, 2001 eruption. In this true color composite MODIS
image (R-G-B of 1-4-3) from February 21, 2001 at 2255 UTC, the ash fall deposition falls within the
dashed white line region. The ash fall is seen as a discoloration on the snow on Umnak Island. Nikolski, the
nearest populated village to Mt. Cleveland, had about 5 hours of ash fall deposition on February 19th from
this eruption.

but only had a pixel integrated radiant temperature of -1.7° C in a background of -6° C.
All the anomalies since the February 19th eruption extended from the summit region
down the west flank of the volcano.
The second explosive eruption from the volcano began on March 11th at around
1330 UTC based on GOES-10 and AVHRR images (Dean et al., 2002a; Dean et al. 2004;
and McGimsey et al., 2004). Dean et al. (2002a and 2004) and McGimsey et al. (2004)
add that the eruption lasted for 3.5 hours (until about 1700 UTC) and the ash clouds were
tracked for about 42 hours until March 13th (from GOES-10, 10 AVHRR images, and 2
MODIS images). Three AVHRR images and two MODIS images on March 11th contain
ash plumes and clouds, but only the two MODIS images contain thermal anomalies.
There were more clouds around the volcano during this time, which made thermal
anomaly observation more difficult. A Landsat 7 ETM+ image was also acquired on
March 11th (2208 UTC). The eruption plume is seen in the Landsat 7 ETM+ image
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extending to the northeast. There was pronounced thermal activity on the western flank.
Based on the observation of the ash cloud 38 km east of the summit in the last AVHRR
image (1747 UTC) on March 11th, and the plume emitting from the crater in the Landsat
7 ETM+ and MODIS (2245 UTC) images, there were at least two eruption pulses on
March 11th (Figure 5.6). In the Landsat 7 ETM+ false color composite image (RedGreen-Blue combination of 7-5-4) a lava flow can be seen on the western side with a
large thermal signal (Figure 5.7). The apparent “glow” observed around the western lava
flow is due to radiance smearing and atmospheric scattering effects (Wright et al.,
2001a). There are also two other narrower flows that extend south and southeast from the
summit, the initial signs of which can also be seen in the Burke Mees photo from Figure
5.7. In the thermal band there is a very bright anomaly at the summit and one two-thirds

of the way down the western flank. The two narrow flows to the south and southeast are
also evident in the thermal band of the Landsat 7 ETM+ image (Figure 5.8). This same
summit to western trending anomaly can be seen in AVHRR and MODIS images on
March 12th to 18th (26 total images).
The third explosive eruption on March 19th was reported to begin around 2330
UTC and last for 6 hours (Dean et al. 2002a; Dean et al., 2004; and McGimsey et al.,
2004). However, a MODIS image from 2155 UTC displayed the existence of a plume
that leads to the eruption beginning at least two hours before the reported time (Figure
5.9). An anomaly was present in 17 AVHRR and MODIS images from March 20th to

24th. The majority of the thermal anomalies during these five days were located from the
summit to the western flank, but there were three images that also displayed anomalies
extending down the south and southeast flanks (MODIS and AVHRR on March 22nd and
AVHRR on March 23rd). Dean et al. (2002a and 2004) and McGimsey et al. (2004)
indicate that there was continued thermal anomalies in other AVHRR images from late
March through April 2001, but these remaining images are beyond the scope of this
study. Thermal anomalies were continually observed in 10 ASTER and Landsat 7 ETM+
images from June 2001 through April 2004 (Figure 5.10). Thermal activity was observed
at the summit, the western flank where the main ‘a’a lava flow was extruded, and the
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Figure 5.8. March 11, 2001 eruption Landsat 7 ETM+ band 6. Thermal image depicting where the warmer
parts of the eruption deposits are in relation to the summit. The brighter the anomaly the warmer it is, as
shown in the temperature scale. As compared to Figure 5.7, some of the deposits are visible in the thermal
image that are not seen in the false color composite since the thermal energy can be observed through
some thin clouds. The eruption plume is colder than the rest of the deposits because it equalizes faster with
the atmosphere. The image was run through a square root enhancement with a 3x3 high pass filter.

west-southwest flank. The volcaniclastic fan deposit was observed to be warmer than the
entire 2001 deposit in the June 8, 2001 and November 22, 2001 Landsat 7 ETM+ images.
Analysis of the digital photographs from AVO’s initial field season in September
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2001 confirms the existence of an ‘a’a lava flow that reached to within 100 to 175 meters
of the ocean on the new fan deposit and to within a few 10’s of meters of the ocean at the
southern fork of the flow (Figure 2.5). The lava flow extended down the western flank
and reached a cliff area, which diverted part of the flow south and part of it north. The
northern part continued to flow on top of the volcaniclastic deposit until it was again
diverted north and south when it encountered the highest point of the fan deposit. The
southern part also flowed over the volcaniclastic deposits and buried most of the
volcaniclastic debris in this area. In Forward Looking Infrared Radiometer (FLIR)
images, taken by Jon Dehn of AVO, the volcaniclastic debris flow fan deposit is observed
to be warmer than the ‘a’a lava flow seven months after the March 11th eruption (Figure
5.4), while fumarolic areas within the fan deposit and the lava flow display the highest

temperatures (~91° C).
Though the March 19, 2001 eruption was the last explosive eruption from the
volcano, a newly acquired ASTER image from November 6, 2001 displayed signs of a
possible steam plume extending southeast from the volcano (Figure 5.11). In the four
field seasons since the 2001 eruptions, the volcano has been observed to emit minor
steam from the crater fumaroles and emits gas plumes of mostly SO2. The remaining field
seasons at Mt. Cleveland in 2002 through 2004 were dedicated to geologic mapping of
the volcano for the production of a hazard assessment for the Alaska Volcano
Observatory. The thermal anomalies observed in ASTER images during this time located
around the crater region. This became a more interesting observation when it was
discovered that between the September 2002 and August 2003 field seasons that the
southern part of the crater had collapsed (Figure 5.12). Field parties between 2002 and
2004 witnessed visual and audible observations of rock falls from the summit.
5.2 Thermal Flux and Effusion Rate
Thermal data from satellite images has been used to look for changing activity
within a volcanic system (Dean et al., 1998). Many of the activity changes are usually
attributed to whether a thermal anomaly is present or not. One way of using these thermal
data was the development by Dean et al. (1998) and Dehn et al. (2000) of the Okmok
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Figure 5.11. Possible November 6, 2001 steam eruption. This ASTER false color composite image (R-G-B
of 2-3-1 respectively) shows a possible steam plume that extends to the southeast for about 10 km
(indicated by the yellow arrow). Though the image is cloudy, the plume’s signature can be seen in the
thermal image from Figure 5.10 (image B). This activity was previously not documented since normal
monitoring satellites used by AVO are of lower spatial resolutions (1-5 km) and would most likely have
missed this weak plume. This plume may be normal degassing from the volcano since shorter plumes of
steam and aerosols were observed during field campaigns. The image was 2% linearly enhanced with a
3x3 high pass filter.

algorithm. The overall goal of this algorithm is to detect changes in the thermal
brightness temperatures from satellite images. Figure 5.13 (A) is a graphical
representation of the Okmok algorithm on the Mt. Cleveland thermal data used in this
study from AVHRR (bands 3 and 4), MODIS (bands 21 and 22), and Landsat 7 ETM+
(band 6). The graph displays the trend of the thermal data where there is an increase in
temperature received by the satellite at the beginning, or just after the beginning of the
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Figure 5.13. “Okmok algorithm” plots for satellite temperature data. (A) Highest pixel temperatures with
time for the four thermal satellite sensors used. The temperatures for the different bands are indicated
along with the times of the volcanic activity. (B) Similar graph as the one above with 5 point running
average described in the text. The Julian time on the x-axis is the number of days since the beginning of
2000, but ranges from January to April 2001 in these graphs.
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three eruptions. Figure 5.13 (B) is a similar graphical representation of the data from part
(A), but these data have been run through a 5 point running average made by taking a

group of 5 data points and averaging them together. This is repeated by moving one data
point forward for the group of 5 points. Outliers in the data are constrained by the
averaging process. From the averaged graph, there is a peak in the thermal temperature
with each of the first two eruptions, but a day or two later for the third eruption.
Temperatures steadily increase before the eruptions, and steadily decrease after the
eruptions. The only questionable areas of the graphs are after the second eruption, and
during and after the third eruption. Here, there are spikes in the data.
The highest thermal output during all the eruptions occurs within the first day or
two after the February 19th event. Table 5.1 shows the estimated thermal flux and
effusion rate calculated from the satellite data. The results are divided between the
combined group of all satellite data and the short or long wavelength dependent data. An
average eruption volume is calculated by taking an average value for all three groupings
of these data for each eruption and the total eruption period: (1) 4.22 x 105 m3 (±1.20 x
105 m3) for February 19, 2001, (2) 2.27 x 105 m3 (±6.31 x 104 m3) for March 11, 2001,
(3) 6.89 x 104 m3 (±2.08 x 104 m3) for March 19, 2001, and (4) 1.12 x 106 m3 (±3.07 x
105 m3) for the entire eruption period from January to late March 2001. This does not
include the volume of the erupted ash material, which has not yet been produced for the
entire eruption period. Watson et al. (2004) and Gu et al. (2005) present analyses of
satellite data for only the February 19, 2001 eruption and calculated between 20 and 650
kt of fine ash erupted respectively. The total eruption volume for Mt. Cleveland between
January and March 2001 is an order of magnitude less when compared to the 1999
eruption of Shishaldin Volcano, Alaska.
5.3 General Stratigraphy of the Volcaniclastic Debris Flow Fan Deposit
Analysis of digital photographs from the 2003 field season indicates that the
deposition of the breadcrust bombs is concentrated into three lobes on the surface of the
volcaniclastic debris flow fan. These lobes are observed in a rough topographic contour
map of the volcaniclastic debris flow fan deposit in Figure 5.14 as higher topographic
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Figure 5.14. Topographic contour map of the volcaniclastic debris flow fan deposit. Elevation data was
gathered using a Garmin 12XL handheld GPS unit and the data could be found in Table 3.9. The contour
map is not drawn to scale and the actual perimeter of the fan deposit is not as straight as it may appear.
Labels on the contour image are BCB for Breadcrust Bomb facies and AB for ‘A’a Block Facies. These
labels indicate the more concentrated of areas of each facies. One can see the three separate lobes of the
Breadcrust Bomb facies at the center and to the north on the fan deposit. The inset in the upper right
displays a 3-D view of the deposit looking east. The three lobes have been numbered 1, 2, and 3. They have
also been shaded for easy discrimination. The vertical exaggeration of this 3-D view is not drawn to scale.
For an overall make-up of each pixel of the fan deposit, see Figure 4.3.
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areas. Panoramic photos in Figure 5.15 show the way these deposits looked when viewed
from the 2001 lava flow. The breadcrust bomb laden deposits, on the surface, appear to
be thinner than the hotter pyroclastic material that was initially deposited (Figure 5.16).
Figure 5.16 focuses on the edge of the deposit. A distinct contact separates a

lower thicker deposit (>5 m; most of which is below sea level or covered by larger eroded
blocks) and the upper thinner (1-3 m) deposit. The lower deposit shows normal grading
(coarser material on the bottom that gets finer at the top), is poorly sorted, and seems to
be matrix supported. The upper deposit has slight inverse grading, but is poorly sorted in
a clast supported matrix. The upper deposit is also darker in color than the lower deposit,
but this is probably not a good descriptor of the units since other outside weathering
sources may be the cause of the coloration. Both units appear to have very large ‘a’a
blocks and breadcrust bombs mixed in with the other finer material, but as observed in
Figure 4.3, the breadcrust bombs are concentrated near the surface and on the surface of

the entire volcaniclastic debris flow fan deposit. The grain size composition of these
deposits provides some insight into the deposition mechanisms.
5.4 Erosion and Morphologic Changes
The time sequential radar satellite images from March 2001 to October 2003
display the erosion of the volcaniclastic debris flow fan deposit formed by the February
19th eruption. This is also observed when comparing the June and November 2001
Landsat 7 ETM+ images. In all cases, the fan deposit is eroded through wave action (seen
in Figure 5.17 when comparing a 2001 photograph to 2003 photographs). Some of the
material is redepositing on the northern beach, on the southern beach, and the rest may
fall further below sea level (Figure 5.18). High winds, rain runoff, and snowmelt runoff
from the constant storms in the Aleutians also redeposited the finer grained material
(Figure 5.19). The changing dimensions of the fan deposit through time is represented in
Figure 5.20 as the starting image from March 31, 2001 in red, the final image from

October 23, 2003 in green, and a reference (before) image from November 13, 1999 in
blue. The same figure shows that the material has been redeposited to the north and
south, and where the lava flow’s advance stopped (in yellow).
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Figure 5.19. Photo comparison of wind redeposition of eroded fan material. (A and B) Photos taken by
Jon Dehn of AVO in September 2001. (C and D) Photos taken during the 2003 field season close to the
same locations as in August 2003. Both photo comparisons show that the rocky beach from 2001 has been
transformed into a smoother surface two years later by wind redeposition. Fine-grained material
transported by rain-wash, snowmelt water, and likely high surf from some large storms have also
contributed to the smoothing of the beach surfaces.
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6.0 DISCUSSION

6.1 Chronology Updates
Five points have come out of updating the chronology of the February to March
2001 eruptions. First, the February 19th eruption may have had two pulses of activity.
Second, the two March eruptions lasted longer than previously reported and each of them
may have had two or more pulses. Third, the timing and formation mechanism of the
volcaniclastic debris flow fan deposit is constrained. Fourth, there was additional activity
and morphologic changes after the March 19, 2001 eruption. Finally, preliminary
geologic maps of the deposits are produced. The satellite observations that were
described by Dean et al. (2002a and 2004), Simpson et al. (2002), and McGimsey et al.
(2004) on the February 19, 2001 eruption meant that this eruption did not need much
updating for this study. However, less information was reported on the March eruptions
from those studies. The Landsat 7 ETM+ image from March 11, 2001, some additional
AVHRR data, and the addition of MODIS data for this study provided more detail to the
March eruptions.

6.1.1 Eruption Pulses and Lengths
The February 19, 2001 eruption produced a bidirectional plume with each portion
reaching a different altitude. The existence of an upper level wind shear is the main cause
behind the two directions, but another source could be from two eruptive pulses closely
spaced in time. As observed in Figure 5.2 (A), and from Dean et al. (2002a and 2004)
and Simpson et al. (2002), the southeastern more translucent plume is at a lower altitude
than the higher more opaque northwestern plume. No indication of multiple pulses was
observed for this eruption in the seismic data from the Makushin network due to the
distance that the seismic waves had to travel (Caplan-Auerbach et al., 2004). It is possible
that the initial burst of the eruption was a “clearing of the throat” burst that produced a
weaker pulse. This initial pulse would not have had the energy to reach higher altitudes.
The translucent nature of the lower southeastern plume may also relate to a longer
suspension time needed to disperse the ash. Once the “clearing of the throat” has
occurred, the second pulse quickly follows. More energy is associated with this second
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pulse in order for the plume to reach a higher altitude. The opaque nature of this pulse
indicates that less time has elapsed for dispersion of the ash to take place. This is the
likely scenario for the February 19th eruption, but without on site observation there exists
the possibility that these two pulses may be reversed in timing.
As mentioned earlier, Dean et al. (2002a and 2004) reported that the March 11,
2001 eruption began around 1330 UTC and ended around 1700 UTC. Figure 5.6 shows
that the observation of the ash plume in three AVHRR images and one Landsat 7 ETM+
image suggests either that there was a longer eruption on March 11th, or that there was
more than one eruption on this day. The argument for an eruption of at least 1-5 hours
longer is made by observing in Figure 5.6 (B-D) that there are ash clouds still close (3740 km) to the volcano in the AVHRR split-window images and an ash-poor plume from
the summit in the Landsat 7 ETM+ image. If the near-vent portions of these ash clouds
are opaque, the eruption is ongoing, and the ash clouds should then be referred to as ash
plumes. It has been shown by Prata (1989) and Prata et al. (2001) that the opaque part of
plumes may not always produce a split-window signal because of the larger particle
concentrations, particle sizes, and gases. This argument is the least likely of the two
because, after reviewing the AVHRR band 4 thermal infrared images, the near-vent
portions of the ash clouds appear to be not as opaque in the 1720 UTC and 1747 UTC
images as it is in the 1606 UTC image when it was still an ash plume. Since the later two
AVHRR images were not as opaque they should have displayed a split-window signal if
they still were ash plumes. Since the ash clouds in B and C (Figure 5.6) are detached
from the summit and an ash-poor plume is observed under five hours later in the Landsat
7 ETM+ image, the most probable argument is for two or more eruptions on March 11,
2001. The earlier eruption was more ash laden than the later eruption.
As observed in Figure 5.9, the addition of the 2155 UTC MODIS image for the
March 19, 2001 eruption helped to show that the eruption likely began 1.5 hours earlier
than the previous report of 2330 UTC from Dean et al. (2002a and 2004). Similar to the
February 19, 2001 eruption, the possibility exists that there were two pulses to the March
19, 2001 eruption since there is a bifurcation of the ash plume observed in both images in
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Figure 5.9. Radiosonde upper air data from Cold Bay, Alaska at 1200 UTC March 19,

2001 and 0000 UTC March 20, 2001 was examined to determine heights and directions
of plume movement. The MODIS image from 2155 UTC had a band 31 temperature of
the brighter west-east plume, traversing the southern edge of Chuginadak Island, of -15°
C. The temperature of a southern diffuse ash plume (~20 km south of the volcano) had a
band 31 temperature of -11° C. From these upper air data the west-east plume is at an
altitude of 3.5-4 km with the wind out of the west-northwest at 10-15 knots (5-8 m/s),
while the southern portion was at an altitude of 3 km with the wind out of the northwestnorth at 15-20 knots (8-10 m/s). The 0330 UTC AVHRR image had a band 4 temperature
near the summit at -21° C, at the eastern concentrated part of the plume at -11° C, and the
southern-most part of the plume at -5° C. These upper air data from 0000 UTC on March
20, 2001 show these temperatures to be associated with altitudes of 5 km, 3 km, and 1.5
km respectively, and wind speeds are around 20 knots out of the west, 5-15 knots out of
the west-northwest, and 15 knots out of the north respectively. Overall, the upper air data
support the idea that the west-east portion of the plume is at a higher altitude between 3-5
km while the southern portion is at a lower altitude between 1.5-3 km. These different
altitude ranges for the plume are likely due to two pulses in the eruption, one pulse being
stronger than the other pulse to force the ash to a higher altitude. The weaker upper level
wind shear of this eruption makes it more difficult to determine which pulse came first.

6.1.2 Timing and Formation of the Fan Deposit
The formation mechanism of the volcaniclastic debris flow fan deposit is subject
to debate, but the observational time frame for its creation is confined to between
February 2, 2001 and February 21, 2001 since this is when the initial signs of nonsatellite observed activity took place. However, it now seems that the fan may have been
deposited some time between February 12th and February 21st (the last satellite thermal
anomaly and the first visual observation respectively). Though this can not be constrained
from actual field observations, the satellite evidence would indicate that the anomalies
from February 4th, 6th, and 12th are most likely connected to the activity depicted in the
February 2nd photo (Figure 2.4) since the amount of energy being detected by the sensors
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is very small (around 2-6 MW). The anomalies from February 19-21 are likely associated
with the deposition of the volcaniclastic debris flow fan deposit and the beginning of the
lava flow since the anomalies are predominantly on the western flank. It should also be
added, from the absence of actual field observations, that there is the real possibility that
the entire pyroclastic fan was created in one catastrophic depositional episode on the
same day as the February 19th eruption. This is in agreement with Dean et al. (2004), that
the deposit was created in 1-2 days. One line of evidence for the deposition to be on or
just after February 19th is that in the days preceding the eruption there is no clear signs of
ash plumes or ash clouds. These signs would be related to the rapid disintegration of rock
material falling down the volcano’s slopes. However, some of the period before the
February 19th eruption is during cloudier conditions and could have hidden any
disintegrating material created ash plumes from the satellites. Another view on how the
volcaniclastic debris flow fan deposit was created is from the deposits spalling off the
lava flow fronts. There appears to be too much material deposited (at least 1.2 x 106 m3
above sea level) in order to make up the volcaniclastic debris flow fan than would have
spalled off a flow front. This is especially the case when less than or equal to half of the
deposit is under water, but some material had to spall off the flow front anyway due to
the steep nature of the upper slopes of the volcano. The material that did spall off is
probably related to a thinner deposit that is part of the fan’s stratigraphy.
No matter when the volcaniclastic debris flow fan was deposited, its deposition
mechanism seems apparent. Figure 6.1 shows the concept behind the fan’s deposition.
As observed in the photo in Figure 2.1 (A) and during the field campaigns, the normal
background activity at Mt. Cleveland is made up of fumarolic degassing at the summit
(Figure 6.1 A). When atmospheric conditions are just right, short and diffuse aerosol
plumes are produced. Sulfur is smelled whenever these plumes are forced to the surface
by differing pressure conditions. The presence of the breadcrust bombs suggests that
Strombolian activity is another common occurrence and concurrent with eruptions. This
type of activity may account for the lahar deposit observed on February 2, 2001 (Figures
2.4 and 6.1 B). Melting of the snow could also be caused by a lava flow/pond within the
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Figure 6.1. Cartoon scenario for the depositional sequence observed at Mt. Cleveland. See text for detailed
description. Cartoon is not drawn to scale. (A) Normal background phase. (B) Initial Strombolian phase
activity. (C) Major eruption phase with example for February 19, 2001 that also produces a thick
volcaniclastic debris flow deposit. (D) Initial lava flow phase that produces thinner collapsed flow front
and remobilized volcaniclastic debris flow. (E) Final emplacement of the lava flow and post-activity
seasonal lahar phase. The red dates next to each stage letter are example dates during the 2001 eruption
that corresponds to the activity of the depicted stage.
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vent, and may not be visible to photo and satellite observation at that time.
Next, the February 19th eruption caused the collapse of material near the summit
leading to the formation of the volcaniclastic debris flow fan (Figure 6.1 C). When the
lava flow begins to flow down the western flank, some of the flow front spalls off and
forces other prior pyroclastic deposits to careen down the slope forming a thinner deposit
on the thicker initial deposit (Figure 6.1 D). The secondary deposition might also aid in
insulating the hotter deposit for several months (see Figure 5.4). Some of the heat within
the volcaniclastic debris flow fan deposit may be from the burial of larger lava blocks.
The final stage in Figure 6.1 (E) depicts the final emplacement of the lava flow
on top of the previously deposited volcaniclastic debris flow fan deposits. Later in this
stage, thin lahar deposits flow down other portions of the volcano during seasonal snow
melting episodes. One of these post-eruption lahars is located on the northwest flank of
the volcano as part of the same lahar channel depicted in Figure 5.3. The Landsat 7
ETM+ thermal image in Figure 5.8 does not show any radiative energy from this
northwest region during the March 11, 2001 eruption, but there is a backscatter area in
the lahar channel in the March 31, 2001 RADARSAT-1 image of Figure 5.20. This
would indicate that the northwestern lahar was deposited either with or just after the
March 19, 2001 eruption.
Evidence for this eruptive sequence has shown up in other pyroclastic deposits
located near the fan deposit (Figure 6.2). From the sequence displayed in Figure 6.2 it is
observed that there have been at least 2 previous episodes in the volcano’s past that have
resulted in the deposition of volcaniclastic debris flow deposits that were then followed
by lava flows. The other sign of evidence for the deposits on the snow is seen in Figure
6.3. Some of the material that was deposited on top of the snow acted as an insulator and

prevented the snow from melting. This has implications for the stability of the volcanic
slope since in a future eruption there could be fracturing of the summit area that releases
heat. This heat could melt the snow to the point that it creates instability in the material
above it causing a collapse. This sequence has recently been observed at Klyuchevskoi
Volcano on Russia’s Kamchatkan Peninsula in January to March 2005 (Olga Girina,
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Figure 6.2. Stratigraphic evidence of eruptive sequences. View in August 2003 from the southern part of
the fan deposit looking east-northeast. The southern lobe of the 2001 lava flow is next to the older deposits,
which lead to the conclusion that this was not the only time that volcaniclastic debris has flowed down this
flank of the volcano. The sequence is labeled and shows a deposition of volcaniclastic debris to brecciated
material to lava flow, similar to the observed sequence from the 2001 eruption. This suggests that this is a
common occurrence for this volcano. Other Aleutian stratovolcanoes may display this stratigraphic
sequence.

KVERT, written communication, 2005). The eruption produced Strombolian eruptions
that led to a lahar. A lava flow then flowed down this same channel and created some
phreatic plumes when the lava reacted with the snow and ice (Olga Girina, KVERT,
written communication, 2005).

6.1.3 Additional Post-Eruption Activity
Further activity at Mt. Cleveland after the last explosive eruption in March 2001
was observed in the form of thermal anomalies in the higher resolution images of ASTER
and Landsat 7 ETM+. An ASTER image from November 6, 2001 (Figure 5.11)
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Figure 6.3. Deposits of volcaniclastic material on top of snow. The top photo, taken in August 2003,
displays the 2001 lava flow extending from the summit looking east at the western flank. The dashed yellow
lines depict the boundaries of the 2001 lava channels. The white hashed region is to show either where a
break in slope, a collapse scarp face, or the distal edge of a secondary lava flow is within the main
channel. This red hashed area seems to coincide with where debris is deposited on the snow that is visible
on the left side of the channel. Photo A (taken by Jon Dehn in September 2002) and photo B (taken by Ken
Papp in September 2002) display examples from the northeastern flank of the volcano of what these
deposits look like sitting on the snow. Although the deposit is not thick it still has the ability to insulate a
thicker layer of snow below it, but melt channels still cut under the deposits to destabilize the entire
sequence. Additionally, ash layers can also be seen within the snow as pointed out by Ken Papp in photo A.
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particularly shows a steam plume extending southeast. This steam plume is likely due to
the increased fumarolic output caused by the atmospheric conditions at the time. There is
also the possibility that it is a minor phreatic plume created from the interaction between
snowmelt and hot material within the crater. There are many summit fumaroles
represented in Figure 5.12 that may have produced the needed steam to form a short
plume. These fumaroles are also creating the necessary conditions, through hydrothermal
alteration, to weaken the summit edifice of the volcano to produce the observed collapse
shown in Figure 5.12. The rock falls that were observed to occur during field campaigns
were probably related to the beginning stages of minor collapse events at the weakened
crater rim.

6.1.4 Preliminary Eruption Deposit Geologic Maps
Prior to the production of a more thorough geologic map for the hazard
assessment by AVO scientists, the final part to the chronology is summed up in the posteruption deposit maps of Figures 6.4 and 6.5. The production of Figure 6.4 was done by
taking the existing Landsat 7 ETM+ images and producing registered false color
composite images. These false color composite images were then investigated to
determine the overall outlines of 2001 eruption deposits similar to Figure 2.3 from before
the eruptions. Figure 6.5 displays the overall area of deposition on Chuginadak Island for
the ash that was erupted from the volcano between February to March 2001. These area
outlines were made from field observations and the investigation of the March 11, 2001
Landsat 7 ETM+ image that contains an eruption plume. These post-eruption deposition
maps can only be considered preliminary as geologic maps because snow cover on the
images and the lack of field observations above an average elevation of 300 meters
prevented a precise assessment to the mapping of geologic units.
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6.2 Lava-Snow/Ice Interaction
The instability created by the deposition of pyroclastic material on top of the
snow cover that adorns the slopes of Mt. Cleveland every winter appears to be one of the
key elements in the formation of the volcaniclastic debris flow fan. This lava-snow/ice
interaction is common on Alaskan and other high altitude volcanoes around the world
(Major and Newhall, 1989). The interaction between the pyroclastic deposits and the
snow on the volcano during the February eruption is determined utilizing some equations
given in Pierson et al. (1990) for water budget, reproduced here for clarity:
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Variable units for equations (12) and (13) from Pierson et al. (1990) were done in both SI
and cgs units, which made using them more difficult than needed. Equation (12) had to
be solved using the units that they provided in order for unit cancellations to work.
Equation (13) was easier to use with regular SI units, and then converted to cal/cm2 for
use in equation (12). For equations (12) and (13), Table 6.1 provides an explanation for
each variable, the units, and the values used or calculated to determine how much melt
water the volcaniclastic debris flow fan deposit may have created. Table 6.1 also gives
the variable explanations for equations (14) to (16) to gather more information about the
solid to water ratio.
Using the values in Appendix F (Table F.1) for the thermodynamic heat transfer
scenarios (primarily through conduction processes) given by Figure 6.6, the amount of
time needed to melt 1 m3 of snow is around 1.20 x 105 seconds (or about 1.4 days; from
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Table 6.1. Variables used to calculate snowmelt water. Some values were taken from provided references.
Variables for Equation (12) from Pierson et al. (1990)
Variable Name
Variable
Units
Calculated or Used Value
Melt Water Volume
Heat

V
Q

m3

5.18E+06
2

cal/cm *
2

15959

Area

A

km

Water Heat of Fusion

Hf

cal/g

79.7

ρs

3

0.33

Density of Snow

0.8532

g/cm

Variables for Equation (13) from Pierson et al. (1990)
Variable Name
Variable
Units
Calculated or Used Value
Heat
Q
J/m2#
668178878
Thermal Conductivity
κ
W/mK
2.4
Temperature
To
K
1273.15
Total Time of Contact
t
s
120183
(see Appendix F)
Thermal Diffusivity
m2/s
0.0000008
α
(from Couch et al., 2001)
* Initial value converted from J/m2 to cal/cm2 (4.1868 J = 1 cal)
# Value converted to cal/cm2
Variables for Equations (14) to (16)
Variable Name
Variable
Units
Calculated or Used Value
Melt Water Rate

δV

m3/s

51.1

Melt Water Rate per Area

δVA

m/s

6.0E-05

2

853200

3

9.10E+06

Deposit Area
Deposit Volume

A
Vd

m

m

Figure 6.6 C since it is similar to the 2001 depositional scenario). Also using the heat

and area values from Table 6.1 for the variables in the Pierson et al. (1990) equations, the
estimated maximum total volume of melt water produced by the Mt. Cleveland eruption
is around 5.18 x 106 m3. During the determined amount of time, the melting rate would
be 51.1 m3/s, or 6.0 x 10-5 m/s over the area given. Taking the volume of the
volcaniclastic debris flow fan deposit and the lava flow (Table 6.1) and dividing it by the
melt water volume gives an estimated solid to water ratio of about 1.8:1. Taking this ratio
as a percentage, if valid to do so, would yield 55% of solid material mostly in the form of
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Figure 6.6. Thermodynamic heat transfer scenarios to determine water from snowmelt. The primary heat
transfer used was conduction from: (A) lava to a basal breccia to the snow, (B) lava to the snow, (C) lava
to a basal breccia to varying thicknesses of ash fall to the snow, and (D) lava to varying thicknesses of ash
fall to the snow. The times indicated for each are the time it would take 1 m3 of snow to melt from the
transfer of heat. Diagrams are not drawn to scale, and no change in variable values with time was done in
order to get a first order estimate. Table 6.1 contains values for some of the variables used.

gravel. This percentage along with the inverse grading, poorly sorted mixture, nonstratification, and matrix support for the lower deposit would indicate that the deposit is a
debris flow after Pierson and Scott (1985) and Major et al. (1996). The upper deposit
appears to be a smaller form of the lower debris flow, but is not matrix supported. The
amount of water to possibly produce these volcaniclastic debris flow deposits (5.18 x 106
m3) is similar in order of magnitude to that observed for Mt. St. Helens in 1982 (Pierson
and Scott, 1985) and for the snowmelt of Nevado del Ruiz in 1985 (Thouret, 1990).
Pierson and Janda (1994) provide information about mixed avalanches that they
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define as being a pyroclastic deposit formed from the mixing of snow and pyroclastic
debris from an eruption. At least the western flank deposit forming the volcaniclastic
debris flow fan has a volume of 1.2 x106 m3, which is within the range of volumes of premelted deposits (105-107 m3) given by Pierson and Janda (1994). The deposits from Mt.
Cleveland’s western flank are likely due to one of these mixed avalanches, though
contrary to the deposits described by Pierson and Janda (1994), the Mt. Cleveland deposit
does not appear to have had trapped snow and ice that later melted away (or at least not
visible at the surface). There is a similarity to the scenario given in Figure 6.1 and those
presented by Pierson and Janda (1994) and some presented by Major and Newhall (1989)
– i.e. loading by ballistic fragments, destabilization by the added weight, and rapid loss of
snow-slab tensile strength from localized melting. Overall, the volcaniclastic debris flow
fan deposit could be considered a debris flow generated by a pyroclastic mixed
avalanche.
6.3 Thermal Trends and Case Study from the March 11, 2001 Eruption
The trend in the pixel integrated radiant temperature data displayed in Figure
5.13 is one that indicates lava flow production at the beginning of each of the three

eruptions. This is usually attributed to the band 3 channel of AVHRR saturating out at
around 50° C (Dean et al., 1998; Dehn et al., 2000; Dean et al. 2002a; and Dean et al.
2004). The gradual decay of the temperature values with time after the eruption is normal
for cooling lava flows (Dehn et al., 2000; Dean et al. 2002a; and Dean et al. 2004). The
varying peaks of the temperature data after the March 11th and 19th eruptions may suggest
Strombolian activity after Dehn et al. (2000) and Dean et al. (2002a and 2004), cloudier
periods that are very dominant during these two eruptions, or a combination of both. It is
likely that it is a combination of the two with the presence of clouds during the last two
eruptions influencing the temperature values during the eruptive activity.
The other indicators of the activity type are observed in the thermal flux and
effusion rate graphs (Figures 6.7-6.8). These two graphical figures display the data as
combined thermal band data (Figures 6.7 A and 6.8 A) from AVHRR band 3, MODIS
band 22, and Landsat 7 ETM+ band 6. They also display a wavelength dependent
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Figure 6.7. Thermal flux comparison graphs. (A) Graph showing the total thermal flux during the eruption
time frame. These data are from combining the thermal infrared sensors into one plot. (B) Similar graph as
the one above, only this graph breaks up the data into the specific wavelength regions. The shortwave
thermal infrared is made up of band 3 of AVHRR and bands 21 and 22 of MODIS. The longwave thermal
infrared is made up of band 4 of AVHRR, band 31 of MODIS, band 6 of Landsat 7 ETM+, and band 14 of
ASTER. The negative values of the longwave data are due to anomalous shortwave pixels not appearing as
anomalies in as many longwave pixels. To correct this, non-anomalous longwave pixels would have to be
ignored, but this was not the intent in this study. See text for more information.
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Figure 6.8. Effusion rate comparison graphs. (A) Graph showing the effusion rate during the eruption time
frame. (B) Similar graph as the one above, only this graph breaks up the data into the specific wavelength
regions. These data are plotted similar to Figure 6.7. The reasoning behind the negative values of the
longwave data are similar to that presented in Figure 6.7. See text for more information.
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thermal data graph (Figures 6.7 B and 6.8 B) that breaks up the thermal data into the
wavelength regions of similarity as shortwave (AVHRR band 3 and MODIS bands 21 or
22 from 3.55-3.989 µm) or longwave (AVHRR band 4, MODIS band 31, Landsat 7
ETM+, and ASTER band 14 from 10.3-12.5 µm) data. These later graphs break up the
data because the wavelengths follow Wein’s Displacement Law, which dictates that the
shorter the wavelengths are, the higher the temperature values recorded at the sensor will
be (Sabins, 2000; and Gupta, 2003). Both sets of graphs display similar trends in the data
beginning with a slight increase a couple days before the signs of the lahar (Figure 2.4)
that came down the southwest flank of the volcano. This increase could indicate when the
lahar was originally emplaced, around January 29, 2001. There is very little evidence in
the thermal flux and effusion rate of any activity until the initial eruption on February 19,
2001, suggesting that thermal anomalies in the satellite images from February 4th to 12th
are related to any heat given off by the lahar deposit. The February 19, 2001 eruption
showed the highest thermal output overall, though the secondary peaks in the thermal
flux and effusion rate are probably related to the emission of the lava flow down the
western flank. The thermal energy after the first two to three days drops off rapidly and
remains very low up until the second eruption on March 11, 2001. Due to the cloudy
conditions around the time of this second eruption slightly decreasing the amount of
thermal output, the actual peak for both thermal flux and effusion rate may have actually
been during the eruption and not a couple days later as represented in Figures 6.7 (A)
and 6.8 (A). The observation of a steady rise in the thermal flux and effusion rate during
the March 11, 2001 eruption indicates that since the lava flow is already on the western
flank, the energy output from the eruption is not as rapid as it is in the first eruption.
Inflation of the flow from additional lava would cause cracks to form exposing more
thermal energy for the satellites to detect. The thermal output drops off again after a
couple days from the beginning of the second eruption. The increase around the time of
the third eruption is indicative of the second eruption, but again due to cloudier
conditions may be lower than the actual output. The spike a few days after the third
eruption is probably more indicative of the output during the third eruption since this
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image was not as cloudy. Overall, the steadily decreasing trend in thermal flux and
effusion rate with each successive eruption is what might be expected in normal eruptive
activity. This is due to cooling of the deposits that produce less surface area of molten
material detected by the satellite (Harris et al., 1997a; Dehn et al., 2000; Flynn et al.,
2001; Wright et al., 2001b; and Dean et al., 2004). A study of the wavelength dependency
graphs (Figures 6.7 B and 6.8 B) shows that the higher peak for activity in the February
19, 2001 eruption is associated with the shortwave thermal infrared occurring during the
eruption, while the largest peak later in this eruption occurs at the longer wavelengths.
The later two eruptions appear to display the opposite sequence in that the initial activity
is at longer wavelengths and remains that way for the eruptive periods. This scenario is
investigated later, when an in depth comparison of the March 11, 2001 eruption is done.
Figures 6.9 (A) and 6.10 (A) depict the cumulative thermal flux and effusion rate

(produced similar to Figures 6.7 and 6.8), which reveals the overall higher rate of
thermal output and effusion rate during the initial eruption as compared to the combined
final two eruptions. This supports the idea that the lava flow down the western flank
began after the initial eruption, with at least the second half of the lava flow emplaced
during the second two eruptions. The lava production is indicated by steep slopes in the
cumulative data (Dean et al., 2004). Evidence from the field campaigns suggest that other
lahars were emplaced during the eruption and after all three eruptions, but the thermal
energy from these lahars was too small to increase the thermal output observed in satellite
data and is represented by a near zero effusion rate (i.e. flat portions). Other activity, in
the form of Strombolian bursts, generally follows a gradual slope in the data. The
wavelength dependent cumulative values from Figures 6.9 (B) and 6.10 (B) show that
after the first increase in thermal flux and effusion rate the longer wavelengths emit more
thermal energy throughout the rest of the eruption than the shorter wavelengths. This is to
be expected since the lava flow will form a crust as it cools and produces longer thermal
wavelength energy. The final output from the cumulative effusion rate is an estimate in
the eruption volume for the individual eruptions and the total eruptive period from
January to April 2001 (Table 5.1). Stelling et al. (2002) provide an estimate for the
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Figure 6.9. Cumulative thermal flux comparison graphs. (A) Graph showing the cumulative total thermal
flux during the eruption time frame. (B) Similar graph as the one above, only this graph breaks up the data
into the specific wavelength regions. These data are plotted similar to Figure 6.7. See text for more
information.
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Figure 6.10. Cumulative effusion rate comparison graphs. (A) Graph showing the cumulative effusion rate
during the eruption time frame. (B) Similar graph as the one above, only this graph breaks up the data into
the specific wavelength regions. These data are plotted similar to Figure 6.7. See text for more
information.
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Shishaldin, Alaska eruption at 1.4 x 107 m3. This eruption lasted from April to May 1999
with two major eruptive events (Stelling et al., 2002). For comparison, the Mt. Cleveland
erupted volume takes into account the volcaniclastic debris flow fan deposit’s topography
from Figure 5.14, and the lava flow area times a 10 m thickness for the lava flow
determined from satellite data. The Mt. Cleveland erupted volume was around 9.1 x 106
m3. This last value was used for the melt water calculations earlier in section 6.2.
As stated earlier, the March 11, 2001 eruption provided an opportunity to
compare the thermal data between AVHRR (5 images), MODIS (2 images), and Landsat
7 ETM+ (1 image). These images spanned the first two days of this eruption. The method
behind the thermal comparison is similar to section 4.2, and the results are a subset of
those presented in section 5.2 and displayed in Figure 6.11. The data plotted in Figure
6.11 shows the thermal flux, effusion rate, and their cumulative trends dependent upon

the wavelengths of 3.55-3.989 µm (AVHRR band 3 and MODIS band 21 and 22) and
10.30-12.50 µm (AVHRR band 4, MODIS band 31, and Landsat 7 ETM+ band 6).
The eruption begins on day 436 (March 11, 2001), since the beginning of 2000,
but as shown, the thermal activity does not rise until late on this day when a peak is
reached. The data suggest the thermal energy is mainly in the longer wavelengths during
this eruption and, as reported above, during the third eruption. This is opposite from the
initial eruption on February 19, 2001. Cloudier conditions and the presence of the
eruption plume during the March 11, 2001 eruption will scatter and absorb the emitted
thermal energy from the lava flows, and would decrease the amount of energy reaching
the satellite. The clouds also have a peak emittance in the longer wavelengths, which has
more influence on the radiant energy. As observed in Figures 5.7 and 5.8, the lava flow,
mainly on the western flank, is present in the Landsat 7 ETM+ image. The highest
temperature recorded from these data is around 81° C. The flow is about two-thirds of the
way down the left flank at this time. A thick crust has likely formed on the surface by the
time of this eruption, but molten lava is exposed where there is a break in slope (i.e. half
way down the west flank and at the distal fork of the flow). This would explain the longer
wavelength energy during the second two eruptions since the crust is at cooler
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temperatures than the internal molten lava.
6.4 Continued Morphologic Changes of the Volcano
Examination of the morphologic changes of the volcano from erosion of the
volcaniclastic debris flow fan deposit (Figure 5.20) and the collapse of the southern
crater rim (Figure 5.12) is done by detecting the change of these areas in RADARSAT-1
data. A plot from Figure 6.12, with a similar averaged graph produced in the same
manner as the Okmok algorithm plot from Figure 5.13 (B), shows how much erosion has
taken place over the time frame of these radar data. The overall trend is a decrease in the
size of the volcaniclastic debris flow fan deposit of about 20 m2 per day, but since this
decrease is not as constant, the erosion likely occurred rapidly at some periods in time
(storms) and not as rapidly at other periods. An investigation of when storms may have
been affecting the island did not show any conclusive correlation between the area
decrease and the time of cloudy periods that may have indicated when storms were in the
area. As stated earlier, this erosion rate estimate is a first order determination that results
in a maximum rate due to the area distortions from view angle and non-terrain corrected
data. A 20 m2/day rate is probably more indicative of one or more storm events since the
amount of erosion from single storms have been shown to produce about 5-30 m of
recession to the edge of sea cliffs (Easterbrook, 1999).
The morphologic changes of the summit crater rim as observed from the photos in
Figure 5.12 between September 2002 and July 2004 was investigated in a similar manner

as the erosion of the fan deposit. Figure 6.13 (A) depicts the plot of the areas of the
summit through time and a similar averaged graph of the same data (Figure 6.13 B). The
overall trend in the data suggests an increase in the crater area of 3-4 m2 per day. It is
likely that the increase took place more rapidly at certain times, which may be evident as
large variances from the averaged graph in Figure 6.13 (B). Though the data are rough
first order estimates of the crater area, the averaged graph shows two timeframes of larger
increases during the period in which the crater’s southern rim collapsed – one between
mid-October to mid-November 2002 and another between late-April to early-June 2003.
With no actual concrete observations during the timing of the southern rim collapse, the
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Figure 6.12. Changing area of the fan deposit with time graphs. (A) Area estimates for the pyroclastic fan
deposit taken from RADARSAT-1 data. A linear trend line has been fitted to the data with about 72% of the
data fitting the trend. (B) Similar graph as the one above, only this graph is run through the 5 point
running average described in the text for Figure 5.13. This graph fits about 94% of the data to it. The
legend in B can be used for A. The Julian time on the x-axis is the number of days since the beginning of
2000, but ranges from late January 2001 to October 2003 in these graphs.
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Figure 6.13. Changing area of the crater with time graphs. (A) Area estimates for the crater taken from
RADARSAT-1 data only. A linear trend line has been fitted to these data. (B) Similar graph as above, only
this graph is run through the 5 point running average described in the text for Figure 5.13. The Julian time
on the x-axis is the number of days since the beginning of 2000, but ranges from late January 2001 to
October 2003 in these graphs. The green shaded area represents the time frame for the collapse event
observed in Figure 5.12 (between September 2002 and August 2003). There may have been two collapse
events during this time as observed in the graph by two larger increases (blue ovals) from mid-October to
mid-November 2002 and late April to early June 2003.
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two periods represented by increases in area are the best estimates for the timing of the
collapse to date. It is still not known where the collapsed material went. No field
expedition has made it to the summit to see if any material on the steep south flank is
from the crater rim, or if the material has fallen into the crater. A field expedition with
helicopter support for just this very observation is needed for the proper completion of
any field hazard assessment.
A question that came out of photographic analysis between the 2001 and 2003
photos and field observations from the 2003 field season was, is the western flank of the
volcano uplifting from either magma input to the system or regional tectonics? This
question was raised after the observation of the 2001 coastline to the south of the fan
deposit that had risen by an estimated 1-3 meters by the 2003 field season (Figure 6.14).
Though there is definite evidence from the field photographs that both the north and
south beaches had tripled in size from 2001 to 2003 because of the erosion (Figure 5.18),
the difference between the 2001 rocky coast and 2003 coast (Figure 6.14) would have to
be explained by uplift since sea level has not changed that dramatically. This coastal
change from Figure 6.14 is more than could be accounted for by tidal variations. In a
paper by Lu et al. (2003), interferograms of Mt. Cleveland were produced spanning 20002001. In figure 4b (from Lu et al., 2003), there is the possibility of a western deformation
source, but their conclusions indicate that deformation is not evident during this time.
They add that by focusing on a shorter time frame between repeat passes and with a finer
resolution product, that better deformation information might be collected. The evidence
from the digital field photographs suggest that local deformation is occurring at Mt.
Cleveland, but that the steep slopes prevent proper production of interferograms to view
this deformation. These and other observations suggest that the volcano is still restless,
and should continue to be studied and instrumented by researchers.
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Figure 6.14. Evidence for uplift at the coast. Photo comparison between 2001 and 2003 showing possible
uplift of the west flank. (A) Top photo taken by Jon Dehn of AVO in September 2001, and (C) the same
location in August 2003. The red arrows in both photos represent the same respective locations in the two
photos. The increase in the size of the southern beach next to the volcaniclastic debris flow fan in the 2003
photo is very evident. The sea level difference is also evident in the 2003 photo. The tidal difference in 2003
was observed not to be too significant to produce such a decrease in the sea level. (B) Top photo taken by
Jon Dehn in September 2001, and (D) the same location in August 2003. The red arrow in both photos
represents the same location in both photos. The same difference in sea level as in comparison A and C can
be seen. Also of significant note in both comparisons, the 2003 photos were taken at a vantage point that
was further seaward than the 2001 photos.
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7.0 CONCLUSIONS

The importance of Mt. Cleveland as a hazard is confined to the ash producing
eruptions that affect the heavily traveled air routes of the North Pacific region. With at
least 21 eruptions within the last 230 years, this hazard is one that will continue as long as
the Aleutian subduction zone remains active. The improvements to the 2001 eruption
chronology from this study show that Mt. Cleveland usually produces several different
types of eruptive activity during a single eruption including basic degassing, Strombolian
activity, lahars, snow/pyroclastic debris flows (mixed avalanches), sub-Plinian eruptions,
and effusive lava flows. The timing for the formation of a volcaniclastic debris flow fan
deposit on the western flank of the volcano has been narrowed down to take place
between February 12-21, 2001, but likely occurred along with the initial eruption on
February 19, 2001.
A depositional scenario for the formation of the volcaniclastic debris flow fan has
been produced and matches the scenario for mixed avalanches as postulated by Pierson
and Janda (1994). Strombolian activity and lava flows are presumed to have produced a
catastrophic loading of the snow apron at the summit, which led to this material flowing
downslope. Additional lava flow activity aided in producing thinner flows of material by
lava blocks (at the toe of the flow) spalling off, forcing prior deposits into motion, and all
of this material flowing down the flank.
Thermal remote sensing data from January 29, 2001 to April 29, 2004 has shown
how the activity at the volcano changed with time. Estimates on thermal flux and effusion
rate were produced and show that an averaged total erupted volume of the deposits from
January to late March 2001 is around 1.12 x 106 m3 (±3.07 x 105 m3). Radar remote
sensing data was useful to show that from March 31, 2001 to October 23, 2003, the
volcaniclastic debris flow fan deposit eroded at an estimated rate of 20 m2 per day. It was
also used to estimate the changing dimensions of the summit crater at an area increase of
3-4 m2 per day. Field campaigns observed that a collapse of the southern portion of the
summit occurred between September 2002 and August 2003, but the change in the radar
data indicated that this collapse might have taken place in two collapse events between
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mid-October to mid-November 2002 and another between late-April to early-June 2003.
So far, no study has been able to determine conclusive evidence of deformation at
the volcano before, during, or after the eruption, but some field evidence presented in this
study indicate possible uplift on the western flank of the volcano during the 2003 field
season. This study has provided some possible answers to some of the questions
produced by the 2001 eruption, but some non-related questions for further investigation
are: (a) Why are there so many lava domes on the flanks of the volcano, and how do they
figure into the big picture of Aleutian arc volcanism?, (b) What affect did the amount of
material hitting the ocean, to produce the volcaniclastic debris flow fan, have on the
surrounding islands? - this has implications on tsunami generation, (c) How much of an
impact on the formation of volcaniclastic deposits does the summit snow pack have?, and
(d) Are the depositional sequences observed at Mt. Cleveland occurring at other Alaskan
volcanoes?
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Appendix A
WORLD WIDE WEB SITES USED

Warning: The links below constitute the addresses that were accessed during this
study. Due to the fluidity of internet address, the links below could no longer work in the
future or may have changed to a new address. If this occurs, the best thing to do is check
the parent site (i.e. NASA if the address is from one of their sites) to see if there is a
different category or heading that the site may be under. A search on one of the many
search engines is also a good thing to do. The links are in sequential order, as they would
be found in the main text.
1) Earth Sciences and Image Analysis Laboratory, NASA Johnson Space Center (Section

2.1, Figure 2.1, page 20)
URL: http://eol.jsc.nasa.gov
2) Mt. Cleveland activity updates from Smithsonian Institution Global Volcanism
Program (Section 2.1, Table 2.1, page 21)
URL: http://www.volcano.si.edu/world/volcano.cfm?vnum=1101-24&VErupt=Y&VSources=Y&VRep=Y&VWeekly=Y&volpage=var
3) Mt. Cleveland activity updates from the Alaska Volcano Observatory Weekly Updates
(Section 2.1, Table 2.1, page 21)
May-Jun. 1994 URL: http://www.avo.alaska.edu/avo4/updates/mj94.html
Jul.-Aug. 1994 URL: http://www.avo.alaska.edu/avo4/updates/ja94.html
Jan.-Feb. 2001 URL: http://www.avo.alaska.edu/avo4/updates/avo_010102.htm
Mar.-Apr. 2001 URL: http://www.avo.alaska.edu/avo4/updates/avo_010304.htm
May-Jun. 2001 URL: http://www.avo.alaska.edu/avo4/updates/avo_010506.htm
4) United States Geological Survey Landsat 7 ETM+ viewer (Section 3.1.1, Table 3.1,

page 30)
URL: http://glovis.usgs.gov/
5) Earth Observing System Data Gateway (Section 3.1.2, Table 3.2, page 31; Section

3.1.5, Table 3.5, page 35)
URL: http://redhook.gsfc.nasa.gov/~imswww/pub/imswelcome/plain.html
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6) Alaska Satellite Facility radar data ordering site (Section 3.1.3, Table 3.3, page 32)
URL: http://imswelcome.asf.alaska.edu:8000/~imswww/pub/imswelcome/plain.html
7) Jet Propulsion Laboratory ASTER spectral library data for basaltic andesite (Section

4.2.1, page 44)
URL: http://speclib.jpl.nasa.gov/scripts/lib/asp/buildhtm.asp?DB=rocks&ID=38
8) Landsat 7 ETM+ Science Users Handbook (Appendix B, Table B.1, page 119)
URL: http://ltpwww.gsfc.nasa.gov/IAS/handbook/handbook_toc.html
9) Alaska Satellite Facility radar data information (Appendix B, Table B.2, page 119)
URL: http://www.asf.alaska.edu/2_3.html
10) Alaska Satellite Facility RADARSAT-1 information (Appendix B, Table B.2, page

119)
URL: http://www.asf.alaska.edu/R1stanprod.pdf
11) Alaska Satellite Facility ERS-2 information (Appendix B, Table B.2, page 119)
URL: http://www.asf.alaska.edu/ERS2.pdf
12) United States Geological Survey SRTM information (Appendix B, Table B.2, page

119)
URL: http://srtm.usgs.gov/
13) Jet Propulsion Laboratory SRTM information (Appendix B, Table B.2, page 119)
URL: http://www.jpl.nasa.gov/srtm/index.html
14) United States Geological Survey AVHRR information (Appendix B, Table B.3, page

120)
URL: http://edc.usgs.gov/guides/avhrr.html
15) NOAA Polar Orbiter User’s Guide (Appendix B, Table B.3, page 120)
URL: http://www2.ncdc.noaa.gov/docs/podug/cover.htm
16) MODIS information from NASA site (Appendix B, Table B.3, page 120)
URL: http://modis.gsfc.nasa.gov/about/specs.html
17) SRTM data (Appendix C, page 121)
URL: http://srtm.usgs.gov/data/obtainingdata.html
FTP URL: ftp://e0mss21u.ecs.nasa.gov/srtm/United_States_1arcsec/1arcsec/
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18) Information on EGM96 geoid data (Appendix C, page 121)
URL: http://cddisa.gsfc.nasa.gov/926/egm96/egm96.html
19) NIMA EGM96 geoid calculator (Appendix C, page 121)
URL: http://earth-info.nga.mil/GandG/egm96/intpt.htm
20) 1 Degree USGS DEM for the Samalga West area (Appendix C, page 122)
URL: ftp://agdcftp1.wr.usgs.gov/pub/usgs/dem/1DEG/
Samalga West URL: ftp://agdcftp1.wr.usgs.gov/pub/usgs/dem/1DEG/S/sam_w.gz
21) Global Mapper 5 software site (Appendix C, page 122)
URL: http://www.globalmapper.com/
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Appendix B
SATELLITE SENSOR SPECIFICATION TABLES
Table B.1. Operational and spectral specifications for high resolution satellites. Landsat 7 ETM+ and
ASTER data was gathered from the Landsat 7 Science Users Handbook from the NASA website (Appendix
A) and Yamaguchi et al. (1998) and Abrams et al. (2002) respectively.
Landsat 7 ETM+
ASTER
705
705
Altitude (km)
185
60
Swath Width (km)
16 Days
16 Days (5 if pointed at Target)
Repeat Cycle
Band #
λ (µm)
Spatial Res. (m)
λ (µm)
Spatial Res. (m)
1
0.45 - 0.52
30
0.52 - 0.60
15
2
0.53 - 0.61
30
0.63 - 0.69
15
3
0.63 - 0.69
30
0.78 - 0.86
15
4
0.78 - 0.90
30
1.60 - 1.70
30
5
1.55 - 1.75
30
2.145 - 2.185
30
6
10.4 - 12.5
60
2.185 - 2.225
30
7
2.09 - 2.35
30
2.235 - 2.285
30
8
0.52 - 0.90
15
2.295 - 2.365
30
9
2.360 - 2.430
30
10
8.125 - 8.475
90
11
8.475 - 8.825
90
12
8.925 - 9.275
90
13
10.25 - 10.95
90
14
10.95 - 11.65
90

Table B.2. Operational and spectral specifications for microwave satellites. Information for the two
sensors gathered from the Alaska Satellite Facility websites (Appendix A). Information about the SRTM
data was gathered from the United States Geological Survey and the Jet Propulsion Laboratory websites
(Appendix A).
RADARSAT-1
ERS-2
SRTM
798
780
233
Altitude (km)
100
100
225
Swath Width (km)
24 days
35 days February 11-22, 2000
Repeat Cycle
C
C
C
X
Band #
5.66
5.66
5.66
3.3
λ (cm)
25
25
30 (1 arc second)
Spatial Res. (m)
16 (1 arc second)
Elevation Res. (m)
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Table B.3. Operational and spectral specifications for AVHRR and MODIS. Information on AVHRR was
gathered from the United States Geological Survey website and Kidwell (1998; Appendix A). MODIS Data
was gathered from NASA’s technical specifications site (Appendix A).
AVHRR
MODIS
833
705
Altitude (km)
2399
2330
Swath Width (km)
Multiple/Day at 52 N
1-2 Times/Day at 52 N
Repeat Cycle
Band #
λ (µm)
Spatial Res. (m)
λ (µm)
Spatial Res. (m)
1
0.58 - 0.68
1100
0.620 - 0.670
250
2
0.725 - 1.10
1100
0.841 - 0.876
250
3
3.55 - 3.93
1100
0.459 - 0.479
500
4
10.30 - 11.30
1100
0.545 - 0.565
500
5
11.50 - 12.50
1100
1.230 - 1.250
500
6
1.628 - 1.652
500
7
2.105 - 2.155
500
8
0.405 - 0.420
1000
9
0.438 - 0.448
1000
10
0.483 - 0.493
1000
11
0.526 - 0.536
1000
12
0.546 - 0.556
1000
13
0.662 - 0.672
1000
14
0.673 - 0.683
1000
15
0.743 - 0.753
1000
16
0.862 - 0.877
1000
17
0.890 - 0.920
1000
18
0.931- 0.941
1000
19
0.915 - 0.965
1000
20
3.660 - 3.840
1000
21
3.929 - 3.989
1000
22
3.929 - 3.989
1000
23
4.020 - 4.080
1000
24
4.433 - 4.498
1000
25
4.482 - 4.549
1000
26
1.360 - 1.390
1000
27
6.535 - 6.895
1000
28
7.175 - 7.475
1000
29
8.400 - 8.700
1000
30
9.580 - 9.880
1000
31
10.780 - 11.280
1000
32
11.770 - 12.270
1000
33
13.185 - 13.485
1000
34
13.485 - 13.785
1000
35
13.785 - 14.085
1000
36
14.085 - 14.385
1000
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Appendix C
SRTM DEM CORRECTION HELPFUL HINTS: MT. CLEVELAND EXAMPLE

Obtaining the SRTM data can be done following the steps at this site (be warned
that some site links may change with time, or may not exist any more):
http://srtm.usgs.gov/data/obtainingdata.html or the FTP site:
ftp://e0mss21u.ecs.nasa.gov/srtm/United_States_1arcsec/1arcsec/
Ken Papp (UAF, personal communication) provided some steps to follow in order to
perform corrections on the SRTM DEM:
In order to maximize the absolute elevation accuracy, one must add the average
geoid height of the region to the SRTM elevation values. This is because the SRTM
vertical datum was EGM96 (http://cddisa.gsfc.nasa.gov/926/egm96/egm96.html for more
information). To get WGS84 height from EGM96 elevations, use the following:
HWGS84 = HEGM96 + GEOIDHGT.
Example: HWGS84 = 13.06 m + Image
To estimate the average geoid height for a given region, use the following site:
NIMA EGM96 GEOID CALCULATOR
http://earth-info.nga.mil/GandG/egm96/intpt.htm
Used the above site to calculate the EGM96 Geoid from Mt. Cleveland’s location:
52° 49’ 21.40” N and 169° 56’ 42.38” W
Also calculated for meter units – Got a Geoid height of 13.06 m (other values may be
different). In the remote sensing software package ENVI (one can choose to use another
software package, but the steps will be different), open all SRTM files for Mt. Cleveland
area (using File → Open Image File). There were three files needed for this:
N52W171.hgt, N52W170.hgt, and N53W170.hgt (these are not the .zip files)
A mosaic of these files was produced using Basic Tools → Mosaic → Georeferenced.
Next, a subsectioning of the mosaic file for the needed area was done. Used the ROI tool
to draw a rectangle around this area, then the subsection was made by going into Basic
Tools → Subset via ROI. The file was reprojected by going into Map → Convert Map
Projection → Select File → Selected UTM, WGS-84 Datum, Zone 2, and 100 points
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each to warp. On next window, selected Triangulation method, clicked to edit output
sizes, and changed the pixel size to 30.9099 x 30.9099. Corrected the file for the Geoid
by adding 13.06 m to the image by using Basic Tools → Band Math → Entered the
formula 13.06+b1 → Selected the subsectioned image as b1.
SRTM data has certain areas in which the data is bad due to radar interferences or
other effects, so these bad data areas have to be replaced. Initially these values are around
-32768, but after correcting for the Geoid height, the values will change. To find the
value under the image toolbar use Tools → Cursor Value/Location, position the cursor
over one of these bad data areas, and record the EXACT data value. For Cleveland’s
case, it was -32754.939453 (the actual value may differ). Replace the bad data by
masking: Display your latest DEM file → Basic Tools → Masking → Build Mask →
Select Display # → Options under new window → Import Band Data Range → Enter 0
in Minimum section and OK it. Next, apply the mask by Basic Tools → Masking →
Apply Mask → Selecting the Geoid corrected image → Just above the OK click the
Select Mask Band button and select the mask → Save this file as a GeoTiff format.
Figure C.1 displays the result of these steps.

Steps for further correction of bad data areas in SRTM with a USGS DEM file:
For the Mt. Cleveland SRTM correction, the 1 Degree USGS DEM for the
Samalga West area was downloaded at the following website:
ftp://agdcftp1.wr.usgs.gov/pub/usgs/dem/1DEG/ (the Samalga West file was at:
ftp://agdcftp1.wr.usgs.gov/pub/usgs/dem/1DEG/S/sam_w.gz)
Opened the USGS DEM in the software package Global Mapper 5 that can be
downloaded for a trial version at the following website:
http://www.globalmapper.com/
After the DEM has been opened, it was exported as a DEM file for use in the ENVI
package. Next, open up the latest SRTM DEM file in ENVI (the one that was corrected
so that the bad data values are all 0). Also, open up the Samalga.dem file (Figure C.2) in
ENVI by going to File → Open External File → USGS → DEM → Select the Samalga
West.dem file → Select yes for mosaic files and give the file a name → OK. Reproject
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Figure C.1. SRTM DEM image with bad data masked to zero. This is a hill shaded relief with a sun
elevation of 45° and a sun azimuth of 215° of Chuginadak, Carlisle, and Herbert Islands. Several areas of
the image contained bad data regions from radar interference (an example is indicated). These bad data
regions were masked and corrected to a value of zero.

The Samalga DEM similar to the SRTM DEM from earlier. Reproject it as a UTM, Zone
2, WGS-84 datum, with 100 warp points, triangulation method, and make the output
pixel size the same 30.9099 x 30.9099 as the SRTM DEM. Made a mask of the SRTM
DEM file with a Max value of 0 so that the bad data values will be coded as a value of 1
(Figure C.3).
Next, exclusively stack the mask with the Samalga DEM. Band multiplied the
mask and the Samalga DEM that make up the exclusively stacked image you just
produced. Inclusively stack the band multiplied image and the latest SRTM DEM (that
originally had the bad data values as 0). Band addition was done using the result of the
band multiplication image and the latest SRTM DEM (that originally had the bad data
Values as 0) that were the files from the inclusive stack that was just produced. This
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Figure C.2. Samalga West USGS 1 Degree DEM reprojected image. This is the main part of the hill
shaded relief with a sun elevation of 45° and a sun azimuth of 215° of Chuginadak Island. The blocky
nature of the DEM is due to the resizing of the pixels during the reprojection.

addition will add the Samalga DEM data to the bad data value regions of the original
DEM. Though the spatial resolutions between the SRTM and USGS Samalga DEM are
much different, the resulting DEM will have some data where none existed before
(Figure C.4). It may be good to crop the image for easier use later on, use the ROI tool to
select the region to crop, and save the file as a .tif file.
Steps for using the corrected SRTM data for ArcGIS:
If ArcGIS is available, one can also drape satellite images over the DEM in
ENVI, just follow the steps in the help section for draping images over a DEM in ENVI.
Since you saved the file as a .tif file, this can instantly be used in ArcGIS. Open ArcMap
and ArcCatalog programs. Start new project in ArcMap.
For 3-D viewing, click on the ArcScene button on the ArcMap toolbar. While in
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Figure C.3. Mask of the bad data regions for Chuginadak Island. The white regions are the bad data area
that after creating the mask, have a value of one. This mask is later used to clip the Samalga West DEM.
The clipped data is then added to the original SRTM image so that the bad data regions now contain some
sort of elevation data.

Figure C.4. Final corrected SRTM DEM. This is a hill shaded relief with a sun elevation of 45° and a sun
azimuth of 215° of Chuginadak, Carlisle, and Herbert Islands. Several areas of the image now contain bad
data regions that have data from the Samalga West USGS 1 Degree DEM (an example is indicated). The
blocky nature to the corrected regions is due to the different spatial resolutions of the original DEM’s.
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ENVI, open any Landsat data (or other satellite data with a UTM, Zone 2, WGS-84
datum projection) and go through the steps to make a false color composite image. Save
this image as a GeoTiff image with no spaces. Add the Landsat data to ArcScene by
clicking on the file in ArcCatalog and drag it to the ArcScene window. To make the file
3-D, go to where the file is on the left side in ArcScene, Right Click on it, and go into the
Properties → Click the Base Heights Button if available → otherwise, on the Right side
of the Base Heights box will be a Folder Button – Click on it → Select your DEM file →
If you want any vertical exaggeration other than one enter it in the space for Z Unit
Conversion where the number is, otherwise click Apply, then OK. It is now possible to
view a 3-D image of Mt. Cleveland (or whatever other image you want). Figure C.5
displays an example 3-D view of Mt. Cleveland during the March 11, 2001 eruption.

Figure C.5. Landsat 7 ETM+ image draped over corrected SRTM DEM. This false color composite image
(R-G-B of bands 7-5-4 respectively) displays the March 11, 2001 eruption in 3-D view.
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Appendix D
EXAMPLE AVHRR PIXEL CORRECTION FOR SATELLITE ZENITH ANGLE

Since all the thermal data was analyzed on a pixel-by-pixel basis, the actual areas
of the pixel had to be calculated by using the satellite zenith angle to correct them. The
AVHRR sensor was the only sensor that this was possible from during this study since it
was easily available from the AVO receiving station data. Getting the satellite zenith data
from MODIS proved difficult at best, and thus was not corrected from its original flat
ground pixel area of 1000000 m2. Landsat 7 ETM+ and ASTER were not dealt with for
determining actual pixel area corrections since, along with the difficulty in actually
getting the satellite zenith angles, the finer spatial resolution made correction of the pixel
areas not as important. The areas would not change that much from the original 3600 m2
for Landsat ETM+ and 8100 m2 for ASTER if the pixel were a flat surface.
Harris et al. (1997b) provide the equations used for most of these corrections of
the AVHRR pixel dimensions, and will be reproduced here for completeness:

A = Pa * Pc

(17)

{[

]} { [

Pa = R sin −1 (Ω sin α 2 ) − α 2 − R sin −1 (Ω sin α 1 ) − α 1

α1 = α 0 −
α2 = α0 +

β
2

β
2

]}

(18)
(19)

(20)

Pc = 2(ψ tan γ )

(21)

Sh + R
R

(22)

Ω=

ψ =

(R sin δ )
sin α 0

δ = [sin −1 (Ω sin α 0 )] − α 0

(23)
(24)

Table D.1 describes what the variables in the equations mean, as well as some of the

values used for some of them. The overall areas that were calculated were initially done
in units of square kilometers, but then converted to square meters for thermal
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Table D.1. Equation variables and values used for pixel area calculations.
Variable
Explanation

Value Used

Units

A

Individual pixel area

km2

Pa

Along-scan pixel dimension

km

Pc

Cross-scan pixel dimension

km

R

Radius of the Earth

6378

km

Ω

None

1.130605205

None

α0

Angle from nadir to pixel center (Satellite Zenith)

None

α1
α2
ψ
γband3
γband4
Sh

Angle from nadir to inner edge of pixel
Angle from nadir to outer edge of pixel
None
Band 3 half of cross-scan instantaneous field of view
Band 4 half of cross-scan instantaneous field of view
Satellite height

0.000755
0.000705
833

None
None
km
None
None
km

βband3

Band 3 instantaneous field of view angle

0.00151

mrad

βband4

Band 4 instantaneous field of view angle

0.00141

mrad

δ

Angle from center of Earth to center of pixel

None

calculations. For better understanding of what some of these variables mean visually, the
reader is referred to Figure 3 from Harris et al. (1997b).
An example progression of how the calculations were done follows along with
some example formulas for how to enter things into an Excel spreadsheet that will be
helpful for those who use this software for their own calculations (Table D.2). Overall,
the first step was to gather the satellite zenith for each individual anomalous pixel from
the satellite image. This can be time consuming, especially with large data sets, but it will
pay dividends in the end. Next, each pixel was grouped into a slope angle group based on
where it was located around the volcano (Figure D.1). Also seen from the inset figure in
Figure D.1, each pixel’s satellite zenith was examined to determine whether it was facing

the satellite or facing away from it. Most of the anomaly pixels extended from the summit
to the west flank of the volcano. To determine which way the pixel faced from the
satellite, the cursor was dragged over the pixels from the west flank of the volcano to the
summit to see if the angle increased or decreased. If the zenith angle increased from the
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Table D.2. Equation calculation steps for pixel area. Column A is made up of the variables that are partly
or totally within the equations (18) to (24). Column B is the given values, or calculated values for
comparison. Excel Formula column are how the formulas should be entered into an Excel spreadsheet to
calculate the values. The B2 (etc.) in the formulas refers to the B column and 2nd row (along the left side of
the table) where the value is located for computation. For an explanation on estimated slope angle (row
26), see Figure D.1.
1
A
B
Excel Formula
2
R (km)
6378
3
Sh (km)
833
4
Band 3 Beta (rad)
0.00151
5
Omega
1.130605205
(B2+B3)/B2
6
Gamma
0.000755
B4/2
7
tan Gamma
0.000755
TAN(B6)
8
Zenith Angle (or α0)
39.75
9
sin α0
0.639439002
SIN(RADIANS(B8))
10
α1
39.749245
B8-(B4/2)
11
α2
39.750755
B8+(B4/2)
12
sin α1
0.639428871
SIN(RADIANS(B10))
13
sin α2
0.639449133
SIN(RADIANS(B11))
14
Ω sin α1
0.72294161
B5*B12
15
Ω sin α2
0.722964519
B5*B13
16
arcsin Ω sin α1
46.29788229
DEGREES(ASIN(B14))
17
arcsin Ω sin α2
46.29978211
DEGREES(ASIN(B15))
18
Delta
6.548832195
(DEGREES(ASIN(B5*B9)))-B8
19
sin Delta
0.114049977
SIN(RADIANS(B18))
20
ψ
1137.576451
(B2*B19)/B9
21
Pa (km)
2.486246253
(B2*(B17-B11))-(B2*(B16-B10))
22
Pc (km)
1.717740767
2*(B20*B7)
23
Pa (m)
2735
B21*1100
24
Pc (m)
1890
B22*1100
25
Flat Area (m2)
5167579
B23*B24
26
Est. Slope Angle
35
See Figure D.1
27
Slope Angle- α0
4.75
ABS(B8-B26)
28
cos Slope
0.996565502
COS(RADIANS(B27))
29
cos Slope*Pa (m)
2725
B28*B23
30
Slope Accounted Area (m2)
5149831
B29*B24

west flank of the volcano to the summit, the west flank pixels were facing the satellite.
Thus, the satellite zenith angle was subtracted from the determined slope angle, then an
absolute value was taken to drop any negative result (see row 27 in Table D.2).
Conversely, if the satellite zenith angle decreased as it went from the west flank to the
summit, the west flank pixels were facing away from the satellite. This scenario meant
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Figure D.1. Estimated slope angle determination and use. Photograph of Mt. Cleveland was taken by M.
Harbin of the University of Alaska Fairbanks on July 24, 1994, and provided courtesy of AVO. Since no
actual slope angle measurements were determined in the field, this photo was used to estimate the slope
angle by using a simple protractor to get the angle. Three angle sectors were used for the slope angle: 35°,
29°, and 18°. Each pixel was inspected to determine its relative position on the volcano and divided into
one of these slope angle groups. The inset figure in the upper right depicts how the slope angle and satellite
zenith angle are used. Since the satellite is moving in a certain direction, the pixels on one side of the
volcano will either be facing toward the satellite or facing away from the satellite. If the pixels are facing
toward the satellite, the satellite zenith is subtracted from the slope angle and the absolute value was taken.
If the pixels are facing away from the satellite, the satellite zenith was added to the slope angle. The
resulting angle value is used to correct the AVHRR pixels for topography.

that the satellite zenith angle was added to the slope angle. Originally, before any
correction for slope angle was done, only anomalies where the satellite zenith angle was
less than 55° were analyzed further. This is roughly the highest satellite zenith angle that
would still produce some sort of look at the other side of the volcano. Anything higher
would add error due to shadowing that can’t be taken into account for. Though having a
satellite zenith angle near 55° and facing away from the satellite would produce angles of
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well over 55°, this still provided some view of the other side of the volcano. The pixel in
this case would be very distorted, though.
After determining the satellite zenith angle, and eliminating the ones above 55°,
the next step was to run through the calculations. The calculations can be done in order
and in association with Table D.2. For simplification, Table D.3 indicates which rows
from Table D.2 are associated with its corresponding equation. After running through
these calculations, you are left with the area of the individual pixel if it were a flat
surface. Since the satellite zenith angle can be corrected for slope angle, as stated earlier
in this section (row 27 from Table D.2), the along-scan dimension of the pixel is found
by taking the cosine of the resulting angle (row 28 from Table D.2) and multiplying it by
the along-scan dimension or Pa (row 29 from Table D.2). The resulting new dimension
for Pa is then multiplied by the cross-scan dimension (Pc) to get the final area of the pixel
(row 30 from Table D.2). This final area has the effect of being corrected by a rough
form of topography. At times, the pixels near the summit crater would have to be
calculated differently to take into account for the different dimensions of the topography
at the summit, but this was not done in this study to keep with simplicity. The additional
fact that the summit dimensions are just not that precisely known means that correcting
for the topography at the summit would be very difficult.

Table D.3. Rows from Table D.2 used to calculate equations (17) to (24). For each equation, there is a
corresponding row or rows from Table D.2 that show what variable to calculate and how to calculate it.
Equation Number
Row from Table D.2 used for Calculations
17
25
18
2, 10 to 17, and 21
19
4, 8, and 10
20
4, 8, and 11
21
6, 7, 20, and 22
22
2, 3, and 5
23
2, 9, 19, and 20
24
9 and 18
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Appendix E
EXAMPLE THERMAL FLUX AND EFFUSION RATE CALCULATIONS

For performing the thermal flux and effusion rate calculations, some of the
equations from section 4 have to be utilized. These equations are from Harris et al.
(1997a and 1997b) for AVHRR, but can be used for the other sensors of MODIS,
Landsat 7 ETM+, and ASTER. This appendix is similar to Appendix D in that the
example calculations were done in an Excel spreadsheet. The tables in each section
provide some constant values for the equation variables, and the values produced by the
calculations.
Appendix E.1 AVHRR
The AVHRR example data are found in Table E.1. Since the processing of
UAF’s AVHRR data is done by, using the UNIX based Terascan software provided by
SeaSpace Inc., the data that comes from other data centers would be in different data
values (i.e. radiances, DN values, and/or temperature values). For this study, the UNIX
processing is run to produce both temperature and radiance values for each pixel. From
Table E.1, the band 3 and band 4 radiance values were taken directly from the satellite

image. Background values for each of the two bands could have been taken from the
satellite images, but they are run through the inverse Planck equation (2) from section 4.
For simplicity, each of the increments in the inverse Planck equation was produced to get
a final radiance value. The pixel portion values (lines 54 and 55 of Table E.1) were
calculated from equation (5) from section 4. The non-saturated portion is for band 3,
while the saturated portion is for band 4 and for when the band 3 pixel was saturated.
Equation (6) from section 4 is then used to find the area of the hot pixel. The final
sections of the example calculations come from equations (7) to (11) from section 4. In
these same sections from Table E.1, when the equation column has SUM(all qr or qc
pixels), each of the anomaly pixels from the specific image are included in this function.
Appendix E.2 MODIS
The MODIS example data are found in Table E.2. The data were downloaded
from the EROS Data Gateway (Appendix A). These data were processed in the software
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Table E.1. AVHRR example calculations.
1
A

B

Equation

2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45

Density (kg/m3)
Cp (J/kgK)
f
L (J/kg)
ε
B3 Wave#
B3 Wave#3
B4 Wave#
B4 Wave#3
AVHRR C1
AVHRR C2
Flat Area (m2)
Hot Area (m2)
B3 Temp
B3 (K)
B3 Background
B3 Back (K)
B3 Rad
C1*Wave#3
C2*Wave#
(C2*Wave#)/T
e((C2*Wave#)/T)
(e((C2*Wave#)/T))-1
B3 Back Rad
C1*Wave#3/(e((C2*Wave#)/T))-1
B4 Temp
B4 (K)
B4 Background
B4 Back (K)
B4 Rad
C1*Wave#3
C2*Wave#
(C2*Wave#)/T
e((C2*Wave#)/T)
(e((C2*Wave#)/T))-1
B4 Back Rad
C1*Wave#3/(e((C2*Wave#)/T))-1
T lava (K)
C1*Wave#3
C2*Wave#
(C2*Wave#)/T
e((C2*Wave#)/T)
(e((C2*Wave#)/T))-1
B3 Lava Rad

2600.00
1256.04
0.03
355878.00
0.93
2673.7968
19115479547
925.9259
793832174.3
0.000011910659
1.438833
6548396
6342950
-4.23
268.92
-10
263.15
0.16
227677.9585
3847.1470711
14.61959746
2234655.104
2234654.104

None
None
None
None
None
None
B7^3
None
B9^3
None
None
from Appendix D
from Appendix D
from satellite
273.15+B15
from satellite
273.15+B17
from satellite
B11*B8
B12*B7
B21/B18
EXP(B22)
B23-1

0.10
-6.03
267.12
-10
263.15
64.51
9455.064332
1332.2527405
5.06271230
158.0185285
157.0185285

B20/B24
from satellite
273.15+B27
from satellite
273.15+B29
from satellite
B11*B10
B12*B9
B33/B30
EXP(B34)
B35-1

60.22
1273.15
227677.9585
3847.1470711
3.02175476
20.52728052
19.52728052

B32/B36
None
B11*B8
B12*B7
B41/B39
EXP(B42)
B43-1

46

C1*Wave#3/(e((C2*Wave#)/T))-1

11659.48

B40/B44
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Table E.1 (continued). AVHRR example calculations.
A
B

Equation

47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90

C1*Wave#3
C2*Wave#
(C2*Wave#)/T
e((C2*Wave#)/T)
(e((C2*Wave#)/T))-1
B4 Lava Rad
C1*Wave#3/(e((C2*Wave#)/T))-1
T NonSat p
T Sat p & B4 p
B3 Flat Area (m2)
B3 Hot Area (m2)
B4 Flat Area (m2)
B4 Hot Area (m2)
Band 3 Flat Area
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
dT (K)
Er (m3/s)
Band 3 Hot Area
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
dT (K)
Er (m3/s)
Band 4 Flat Area
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
dT (K)
Er (m3/s)
Band 4 Hot Area
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
dT (K)

9455.064332
1332.2527405
1.04642245
2.84744599
1.84744599

B11*B10
B12*B9
B48/B39
EXP(B49)
B50-1

5117.91
0.0000050
0.0008490
33
32
5559
5385

B47/B51
(B19-B26)/(B46-B26)
(B31-B38)/(B53-B38)
B13*B54
B14*B54
B13*B55
B14*B55

4513754
4513754
329662
329662
4843416
1010.00
0.00

(0.0000000567)*B6*B56*((B39^4)-(B30^4))
SUM(all qr pixels)
10*B56*(B39-B30)
SUM(all qc pixels)
B62+B64
B39-B30
B65/(B2*((B3*B66)+(B4*B5)))

4372142
4372142
319319
319319
4691461
1010.00
0.00

(0.0000000567)*B6*B57*((B39^4)-(B30^4))
SUM(all qr pixels)
10*B57*(B39-B30)
SUM(all qc pixels)
B70+B72
B39-B30
B73/(B2*((B3*B74)+(B4*B5)))

768796983
768796983
56149011
56149011
824945994
1010.00
0.25

(0.0000000567)*B6*B58*((B39^4)-(B30^4))
SUM(all qr pixels)
10*B58*(B39-B30)
SUM(all qc pixels)
B78+B80
B39-B30
B81/(B2*((B3*B82)+(B4*B5)))

744677170
744677170
54387423
54387423
799064593
1010.00

(0.0000000567)*B6*B59*((B39^4)-(B30^4))
SUM(all qr pixels)
10*B59*(B39-B30)
SUM(all qc pixels)
B86+B88
B39-$B30

91

Er (m3/s)

0.24

B89/(B2*((B3*B90)+(B4*B5)))
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Table E.2. MODIS example calculations.
1
A

B

Equation

2
3

Density (kg/m3)
Cp (J/kgK)

2600.00
1256.04

None
None

4

f

0.03

None

5
6

L (J/kg)
ε

355878.00
0.93

None
None

7

C1

3.74E+08

None

8

C2

1.44E+04

None

9
10
11
12
13
14
15
16

B21 λ
B21 λ^5
B22 λ
B22 λ^5
B31 λ
B31 λ^5
Band 21Rad
λ^5*L

3.959
972.58487
3.959
972.58487
11.030
163259.16171
0.1588
485.2079182

None
B9^5
None
B11^5
None
B13^5
from satellite
B10*B15*PI()

17

LN((C1/(λ^5*L))+1)

13.55567988

LN((B7/B16)+1)

18
19
20
21
22

T (K)
T (C)
A (m2)
Back Rad
Back λ^5*L

268.10
-5.05
1000000
0.1272
388.655209

B8/(B9*B17)
B18-273.15
None
from satellite
B10*B21*PI()

23

Back LN((C1/(λ^5*L))+1)

13.77756452

LN((B7/B22)+1)

24
25
26
27
28

T back (K)
T lava (K)
C1/λ5*PI()
C2/λT
(e(C2/λT))-1

263.78
1273.15
122463.57
2.85
16.37

B8/(B9*B23)
None
B7/(B10*PI())
B8/(B9*B25)
(EXP(B27))-1

29

B21 Lava Rad

7482.86

B26/B28

30
31
32
33
34
35
36
37
38
39
40
41

B21 p & B22 Sat p
Hot Area (m2)
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
Max T (K)
dT (K)
Er (m3/s)
Band 22 Rad
λ^5*L

4.22306E-06
4
584017
584017
42679
42679
626695
268.10
1010.62
0.00
0.1589
485.5134647

(B15-B21)/(B29-B21)
B30*B20
(0.0000000567)*B6*B31*((B25^4)-(B74^4))
SUM(all qr pixels)
10*B31*(B25-B74)
SUM(all qc pixels)
B33+B35
MAX(all T values)
B25-B74
B36/(B2*((B3*B38)+(B4*B5)))
from satellite
B12*B40*PI()

42

LN((C1/(λ^5*L))+1)

13.55505035

LN((B7/B41)+1)

43
44

T (K)
T (C)

268.11
-5.04

B8/(B11*B42)
B43-273.15

45

A (m2)

1000000

None
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Table E.2 (continued). MODIS example calculations.
A
B

Equation

46
47

Back Rad
Back λ^5*L

0.1235
377.3499867

from satellite
B12*B46*PI()

48

Back LN((C1/(λ^5*L))+1)

13.80708398

LN((B7/B47)+1)

49
50

T back (K)
T lava (K)

263.21
1273.15

B8/(B11*B48)
None

51

C1/λ5*PI()

122463.57

B7/(B12*PI())

52

C2/λT

2.85

B8/(B11*B50)

53
54
55
56
57
58
59
60

(e(C2/λT))-1
B22 Lava Rad
T NonSat p
Hot Area (m2)
qr (W)
qr (W) Total
qc (W)
qc (W) Total

16.37
7482.86
4.73089E-06
5
654246
654246
47811
47811

(EXP(B52))-1
B51/B53
(B40-B46)/(B54-B46)
B55*B45
(0.0000000567)*B6*B56*((B50^4)-(B74^4))
SUM(all qr pixels)
10*B56*(B50-B74)
SUM(all qc pixels)

61

q (W) Total

702057

B58+B60

62
63
64
65
66

Max T (K)
dT (K)
Er (m3/s)
Band 31 Rad
λ^5*L

268.11
1010.62
0.00
5.1079
2619810.155

MAX(all T values)
B50-B74
B61/(B2*((B3*B63)+(B4*B5)))
from satellite
B14*B65*PI()

67

LN((C1/(λ^5*L))+1)

4.968620676

LN((B7/B66)+1)

68
69
70
71
72

T (K)
T (C)
A (m2)
Back Rad
Back λ^5*L

262.53
-10.62
1000000
5.1079
2619810.155

B8/(B13*B67)
B68-273.15
None
from satellite
B14*B71*PI()

73

Back LN((C1/(λ^5*L))+1)

4.968620676

LN((B7/B72)+1)

74
75
76
77
78
79
80
81
82
83
84
85

T back (K)
T lava (K)
C1/λ5*PI()
C2/λT
(e(C2/λT))-1
B31 Lava Rad
T NonSat p
Hot Area (m2)
qr (W)
qr (W) Total
qc (W)
qc (W) Total

262.53
1273.15
729.55
1.02
1.79
408.51
0
0
0
0
0
0

B8/(B13*B73)
None
B7/(B14*PI())
B8/(B13*B75)
(EXP(B77))-1
B76/B78
(B65-B71)/(B79-B71)
B80*B70
(0.0000000567)*B6*B81*((B75^4)-(B74^4))
SUM(all qr pixels)
10*B81*(B75-B74)
SUM(all qc pixels)

86

q (W) Total

0

B83+B85

87
88

Max T (K)
dT (K)

262.53
1010.62

MAX(all T values)
B75-B74

89

Er (m3/s)

0.00

B86/(B2*((B3*B88)+(B4*B5)))
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package of ENVI 3.6 from RSI. Each image pixel was in radiance values for ease of
calculation, but the temperature value for each pixel was determined as well using the
same inverse Planck equation (2) from section 4. Bands 21, 22, and 31 were used for this
study. Similar to AVHRR, when a pixel in band 22 of MODIS was saturated, the pixel
data from band 21 was then used instead. The rest of the calculations for MODIS (Table
E.2) are similar to the AVHRR calculations.

Appendix E.3 Landsat 7 ETM+
Table E.3 contains the example calculation data for Landsat 7 ETM+. These data

were ordered from the U.S. Geological Survey’s Landsat website, and preliminary
processing information can be found from the Landsat 7 ETM+ Science Users Handbook
(both in Appendix A).The preliminary processing information is used to take the DN
values that the image comes in, and convert it to temperature values. The inverse Planck
equation (2) is then used to convert the temperature data to radiances. The rest of the
calculations in Table E.3 are similar to that of AVHRR and MODIS.
Appendix E.4 ASTER
Table E.4 contains the example calculation data for ASTER. These data were

ordered from the EOS Data Gateway website (Appendix A).The preliminary processing
information is used to take the 16-bit DN values that the image comes in, and convert it
to temperature values using the similar information for converting the Landsat 7 ETM+
DN values to temperature. The inverse Planck equation (2) is then used to convert the
temperature data to radiances. The rest of the calculations in Table E.4 are similar to that
of AVHRR and MODIS.
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Table E.3. Landsat 7 ETM+ example calculations.
1
A
B
3

Equation

2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

Density (kg/m )
Cp (J/kgK)
f
L (J/kg)
ε
C1
C2
λ
λ5*PI
T (C)
T (K)
Rad
Tbackground
C2/λT
e(C2/λT)
e(C2/λT)-1
(λ5*PI)*(e(C2/λT)-1)
Back Rad
Flat Area (m2)
T lava (K)
C2/λT
e(C2/λT)
e(C2/λT)-1
(λ5*PI)*(e(C2/λT)-1)
Lava Rad
T NonSat p
Hot Area (m2)
qr (W)
Total qr (W)
qc (W)
Total qc (W)
qtotal (W)
dT (K)

2600.00
1256.04
0.03
355878.00
0.93
374183200
14387.86
11.45
618268.7645
15.97
289.12
7.6847
278.66
4.51
90.86
89.86
55560571.91
6.73
3600.00
1273.15
0.99
2.68
1.68
1040630.55
359.57
0.002692
9.69
1339803
46459545
96395
3342635
49802179
994.49

None
None
None
None
None
None
None
None
(B9^5)*PI()
None
B11+273.15
None
None
B8/(B9*B14)
EXP(B15)
B16-1
B10*B17
B7/B18
None
None
B8/(B9*B21)
EXP(B22)
B23-1
B10*B24
B7/B25
(B13-B19)/(B26-B19)
B27*B20
(0.0000000567)*B6*B28*((B21^4)-(B14^4))
SUM(all qr pixels)
10*B28*(B21-B14)
SUM(all qc pixels)
B30+B32
B21-B14

35

Er (m3/s)

0.02

B33/(B2*((B3*B35)+(B4*B5)))
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Table E.4. ASTER example calculations.
1
A
B
3

Equation

2

Density (kg/m )

2600.00

None

3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37

Cp (J/kgK)
f
L (J/kg)
ε
C1
C2
B14 λ
B14 λ5*PI
B14 (K)
C2/λT
e(C2/λT)
e(C2/λT)-1
(λ5*PI)*(e(C2/λT)-1)
Rad
B14 Back (K)
C2/λT
e(C2/λT)
e(C2/λT)-1
(λ5*PI)*(e(C2/λT)-1)
Back Rad
A (m2)
T lava (K)
C2/λT
e(C2/λT)
e(C2/λT)-1
(λ5*PI)*(e(C2/λT)-1)
Lava Rad
T NonSat p
Hot Area (m2)
qr (W)
qr (W) Total
qc (W)
qc (W) Total
q (W) Total
dT (K)

1256.04
0.03
355878.00
0.93
374183200
14387.86
11.318
583442.8482
269.27
4.72
112.28
111.28
64926506.78
5.76
268.50
4.73
113.82
112.82
65822035.31
5.68
8100
1273.15
1.00
2.71
1.71
1000137.97
374.13
0.000212812
2
238344
7354759
17318
534391
7889149
1004.65

None
None
None
None
None
None
None
(B9^5)*PI()
None
B8/(B9*B11)
EXP(B12)
B13-1
B10*B14
B7/B15
None
B8/(B9*B17)
EXP(B18)
B19-1
B10*B20
B7/B21
None
None
B8/(B9*B24)
EXP(B25)
B26-1
B10*B27
B7/B28
(B16-B22)/(B29-B22)
B23*B30
(0.0000000567)*B6*B31*((B24^4)-(B17^4))
SUM(all qr pixels)
10*B31*(B24-B17)
SUM(all qc pixels)
B33+B35
B24-B17

38

Er (m3/s)

0.00

B36/(B2*((B3*B37)+(B4*B5)))
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Appendix F
CONDUCTIVE HEAT TRANSFER CALCULATIONS

As part of the determination to calculate melt water from section 6.1, a couple
basic thermodynamic heat transfer equations were solved to determine how long it would
take to melt 1 m3 of snow. Below are the three equations that were used with Table F.1
showing the explanation for the variables and the values used for some of them:
Aκ
l

(25)

q K = Σ(∆Ti K κi )

(26)

Lcritical = LH ρV

(27)

Kκ =

t=

Lcritical
qK

(28)

Equation (25) is for calculating thermal conduction for the scenarios in Figure 6.6. Each
scenario investigates the conductive interaction between: (1) molten lava to a basal
breccia to snow, (2) molten lava to snow, (3) molten lava to a basal breccia to varying
thicknesses of ash to snow, and (4) molten lava to varying thicknesses of ash to snow.
From Table F.1, the thicknesses of the ash layer ranged from 0.05 to 0.30 m and was
varied at 0.05 m intervals. The thickness of the molten lava was varied from 4 to 5 m;
4 m when a 1 m basal breccia was used for the calculations, and 5m when no basal
breccia was used. Only 1 m of snow was used for the calculations. As represented in
Figure 6.6, the assumption that each layer of the conduction process was done in a

thermodynamic series then calculated via equation (26). Next, a critical value for the
latent heat of fusion for the snow was produced using equation (27). This determined the
amount of critical energy needed to melt the 1 m of snow. Equation (28) was then used to
find out how long it would take to melt 1 m3 of snow from the interaction with the
pyroclastic material. Overall, scenario 3 (molten lava to basal breccia to varying ash
thickness to snow) was used to determine the melt water estimates from section 6.1.
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Table F.1. Variables for calculating conductive heat transfer from lava to snow.
Variable Name
Variable Units
Lava
Ash
Breccia
Conduction
Kκ
W/K
Area
A
m2
1
1
1
Thermal Conductivity
κ
W/mK
2.4
0.1
1
Thickness
l
m
4-5
0.05 to 0.3
1
Conductive Heat Transfer
qK
W
Temperature
T
K
1273.15
283.15
1073.15
Critical Latent Heat of Fusion
Lcritical
Ws
110220000
Density
Snow Volume
Time (Scenario 3)
Latent Heat of Fusion

ρ
V
t
LH

kg/m3
3

m
s
Ws/kg

2600

2600

2600

Snow
1
0.21
1
273.15
330

1
120183
3.34E+05

